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IZVLEČEK 

 

Tveganja so neizbežen pojav v gradbenih projektih. Če želimo gradben projekt uspešno izvesti, 

moramo v njegovo pripravo, izvajanje in spremljanje vključiti na primeren način tudi upravljanje 

s tveganjem. 

 

Diplomska naloga prikazuje možen pristop k vodenju projektov in upravljanjem s tveganjem s 

podporo programov MS Project in MS Access. Združil sem možnosti, ki jih nudita programa in 

tako omogočil spremljavo projektov po metodi za ocenjevanje zamud na uporabniku enostaven 

način.  

 

V aplikaciji računalniškega programa MS Access sem pridobil vse parametre, ki so potrebni za 

spremljavo projekta na podlagi omenjene metode, jih prenesel v program MS Project in s tem 

razširil njegovo uporabnost in preglednost. Poleg tega sem v Accessovi aplikaciji izdelal tudi 

obrazec, preko katerega je mogoče vpisovati vzroke za odstopanje posameznih dejavnosti v bazo 

podatkov in vrtilni grafikon, s katerim lahko sproti analiziramo vzroke za zamudo.  

 

Tako spremljanje projekta lahko pomaga pri zaznavi tveganja in nam na pregleden način 

omogoča določevanje zamud aktivnosti in projekta ter pravično končno porazdelitev 

odgovornosti za projektno zamudo. 
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ABSTRACT 
 
Risks are inherent in construction projects. If the project is to be completed successfully, risk 

management has to be included in project preparation, execution and follow-up in an appropriate 

way. 

 

The thesis presents a possible approach to project management and incorporation of risk 

management into the project by combined computer support of MS Project and MS Access. 

Capabilities of both programs were joined, and as a consequence, project follow-up was enabled 

by using the delay estimation method in a user friendly way. 

  

The parameters required for the project follow-up were acquired by the application of MS 

Access, and then transferred into the MS Access. A form for entering causes for discrepancies 

between the planned and as-built schedule into a database was prepared together with a pivot 

chart that can be used for immediate delay analysis. 

 

The presented way of the project follow-up can be used in the risk identification, enables the 

determination of project and activities delays and may lead to a fair final allocation of delay 

responsibilities. 

 
 
 
 

 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  IV                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

ZAHVALA 

 

Zahvaljujem se mentorici doc. dr. Jani Šelih in somentorju dr. Aleksandru Srdiću za nasvete, 

gradivo in pomoč pri izdelavi diplomske naloge. 

 

Posebna zahvala tudi staršem, ki so mi omogočili študij ter vsem profesorjem in delavcem 

fakultete za preneseno znanje. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  V                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

KAZALO VSEBINE 

1 UVOD 1 

1.1 Definiranje problema 1 

1.2 Namen in cilj naloge 1 

2 VODENJE PROJEKTOV 3 

2.1 Projekt 3 

2.2 Definicija uspešnosti projekta 5 

2.3 Vloga vodje projekta 6 

2.4 Življenjski cikel projekta 6 

2.5 Deležniki na projektu 9 

2.6 Projektna komunikacija 10 

2.7 Spretnosti vodenja projektov 13 

3 OBVLADOVANJE TVEGANJA 15 

3.1 Upravljanje s tveganjem kot način vodenja projekta 15 

3.2 Opredelitev in cilji obvladovanja tveganja 17 

3.3 Upravljanje s tveganjem 18 

3.4 Negotovost, tveganje in njihovo upravljanje 19 

3.5 Definicija tveganja 21 

3.6 Proces upravljanja s tveganjem 23 

3.7 Identifikacija tveganja 24 

3.7.1 Identificiranje najpomembnejših udeležencev 24 

3.7.2 Zbiranje informacij 25 

3.7.3 Obravnava komponent tveganja 25 

3.7.4 Identificiranje povezanih tveganj 26 

3.7.5 Prednostno razvrščanje 27 

3.8 Analiziranje tveganja 27 

3.8.1 Ocena treh spremenljivk 28 

3.8.2 Drevo odločanja 29 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  VI                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

3.8.3 Simulacija Monte Carlo 30 

3.8.4 Hevristični pristop 32 

3.9 Kontrola tveganja 32 

3.9.1 Uporaba učinkovitega opozorilnega sistema 35 

3.9.2 Sprejemanje metodologije projektnega vodenja 36 

3.9.3 Planiranje rezerve za nepredvideno 37 

3.9.4 Primerjava s prejšnjimi projekti 37 

3.10 Vrste tveganj in kategorizacija 38 

3.11 Čista in špekulativna tveganja 38 

3.12 Odvisnosti med tveganji 39 

3.13 Vpliv obravnavanja tveganja 41 

4 PODATKOVNI SISTEMI IN BAZE PODATKOV 44 

4.1 Grajenje ER modelov 47 

4.2 Podatkovni modeli in relacijske sheme 48 

4.3 MS Access 51 

5 OBVLADOVANJE TVEGANJA S POMOČJO METODE ZA OCENJEVANJE ZAMUD 

NA ILUSTRATIVNEM ZGLEDU 53 

5.1 Pojasnitev parametrov pri analiziranju časovnega odstopanja aktivnosti 55 

5.2 Spremljanje z MS Accessom 57 

5.3 Spremljanje z MS Projectom 59 

5.4 Spremljava, analiza in napovedovanje konca projekta pri ilustrativnem zgledu 60 

6 ZAKLJUČEK 68 

VIRI 69 

 

 

 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  VII                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

KAZALO PREGLEDNIC 

 
Preglednica 1: Kombinacija aktivnosti upravljanja s projektom in upravljanja s tveganjem 16 

Preglednica 2: Prednosti in slabosti tehnik 28 

Preglednica 3: Dejavniki tveganja, ki nastopajo v posameznih fazah 34 

Preglednica 4: Vsebina tipične metodologije projektnega vodenja 36 

Preglednica 5: Prioritete tveganja 40 

Preglednica 6: Tveganja in koristi pri različnih ukrepih 41 

Preglednica 7: Primer tabele entitet in atributov 49 

Preglednica 8: Prikaz časovne spremljave ilustrativnega primera s programom MS Project 62 

Preglednica 9: Prikaz spremljave ilustrativnega primera po končanem projektu 64 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  VIII                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

KAZALO SLIK 

 
Slika 1: Sistem organizacije 4 

Slika 2: Pomembni faktorji pri vodenju projektov 5 

Slika 3: Integracijsko vodenje projektov 6 

Slika 4: Potrebe po osebju in stroški, ki nastajajo skozi življenjski cikel projekta 7 

Slika 5: Vpliv vodstva na projekt 8 

Slika 6: Interakcija posameznih faz na projektu 8 

Slika 7: Odnos med deležniki projekta 10 

Slika 8: Model komunikacije za projektno vodenje 10 

Slika 9: Vpliv povratnih informacij 12 

Slika 10: Organizacijska izoliranost 13 

Slika 11: Znanja in veščine vodenja projektov 13 

Slika 12: Koristi obvladovanja tveganja 14 

Slika 13: Šest vprašanj 20 

Slika 14: Komponente tveganja 22 

Slika 15: Demingov krog 24 

Slika 16: Prikaz odvisnosti komponent in tveganj s pomočjo Vennovih diagramov 26 

Slika 17: Padanje vrednosti tveganja skozi življenjski cikel 27 

Slika 18: Drevo odločanja 29 

Slika 19: Razširjen drevesni diagram 30 

Slika 20: Postopek simulacije Monte Carlo 31 

Slika 21: Opcije tveganja 33 

Slika 22: Tveganja v življenjskem ciklu projekta 34 

Slika 23: Planiranje rezerv 37 

Slika 24: Toleranca tveganja 41 

Slika 25: Obseg obravnavanja tveganj 42 

Slika 26: Terminsko dostopanje napram meri obvladovanja tveganja 43 

Slika 27: Povezava uporabnik strežnik 45 

Slika 28: Vrste podatkov 46 

Slika 29: ER diagram za entitetno in atribute 48 

Slika 30: Potek izvedbe ilustrativnega zgleda glede na sprejeti terminski plan 55 

Slika 31: Shranjenje ilustrativnega primera iz programa MS Project v program MS Access 57 

Slika 32: Uvoz ključnih podatkov v novo datoteko 58 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  IX                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

Slika 33: Pridobivanje podatkov s poizvedbami 58 

Slika 34: Končna tabela z vsemi potrebnimi parametri 59 

Slika 35: Gantogramski prikaz ilustrativnega primera 63 

Slika 36: Gantogramski prikaz dokončanja projekta 65 

Slika 37: Izdelan obrazec v Accessu 66 

Slika 38: Vrtilni grafikon za spremljanje odstopanj po vzrokih 66 

Slika 39: Prikaz vzrokov za odstopanje začetkov 67 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  1                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

1 UVOD 
 
 

1.1 Definiranje problema 
 

S tveganjem se človek srečuje vsakodnevno na vseh področjih. Pri tveganju gre za verjetnost, da 

bo realizacija nekega dogodka odstopala od našega pričakovanja glede končnega izida. S tem 

imamo v mislih, da je lahko končni odklon v pozitivnem ali negativnem smislu. Pri poslovnih 

odločitvah bi nas torej morali najbolj zanimati dogodki, ki bi prinesli izgubo v širšem smislu: to 

je lahko manjši dobiček od pričakovanega, slaba prodaja, neizpeljanje projekta do konca zaradi 

različnih dogodkov... 

 

Proces izdelave gradbenega objekta je edinstven, zato se v gradbeništvu odvija velika večina dela 

projektno. V okviru gradbenega projekta se pojavlja veliko število raznovrstnih tveganj, ki jih 

moramo, če želimo zagotoviti uspešno izvajanje projekta, obvladovati. 

 

Z analiziranjem, prepoznavanjem in upravljanjem tveganj na projektih lahko projektna skupina 

oblikuje strategijo, ki zagotavlja bolj uspešno izvedbo projekta. To pa lahko pomeni hitrejšo 

izvedbo, manj stroškov in bolj gladko izpeljavo. 

 

1.2 Namen in cilj naloge 
 

V projektnem vodenju se udeleženci pogosto srečujejo s situacijami, ki so mnogokrat podobne 

prejšnjim. V takih primerih lahko določena znanja oziroma informacije prenesemo in uporabimo 

v novem projektu. Koncept ponovne uporabe je dragocen v obvladovanju tveganja, ker se lahko 

projektni vodje hitreje odločajo o napredovanju del oziroma aktivnosti. Zmanjšajo se zamude, 

poveča se učinkovitost, razjasnejo se zahteve itd. Glavni cilj tega je, da tako vodenje omogoča 

hitrejše in učinkovitejše obvladovanje tveganja. Orodij, ki nam pomagajo pri ponovni uporabi 

informacij, je precej, med njimi pa so tudi podatkovne baze skupaj z orodji za njihovo 

upravljanje. 
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Namen naloge je prikazati učinkovit pristop k vodenju projektov in upravljanjem s tveganjem na 

način, ki bi vodjem projekta omogočil enostavno spremljanje projekta s programom MS Project 

in MS Access.  

 

MS Project je odlično programsko orodje, ki nam omogoča planiranje, spremljanje, vizualizacijo 

poteka dejavnosti, operiranje s trenutnimi časovnimi parametri dejavnosti, avtomatsko računanje 

časovnega okna dejavnosti in prilagajanje plana trenutnim razmeram. MS Access pa je uporaben 

pripomoček za upravljanje s podatkovnimi bazami, ki shranjujejo podatke v medsebojno 

povezane tabele – relacijske zbirke podatkov. Pri tem je pomembna pravilna organiziranost 

zbirke podatkov, ki nam kasneje omogoča mnoge načine uporabe in grajenje podatkovnih baz.  

 

Z združitivijo možnosti, ki nam jih omogočata programa, je moč spremljati projekte na 

uporabniku enostaven način. Prednost lahko dosežemo z vzporednim beleženjem vseh odstopanj 

in vzrokov v podatkovne baze, ti podatki pa so nam kasneje lahko v veliko pomoč pri nadaljnjih 

analizah. Več podatkov obvladujemo, boljše so narejene končne analize.  
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2 VODENJE PROJEKTOV 

 
 

2.1 Projekt 

 

»Projekt je začasno prizadevanje napraviti edinstvene izdelke in storitve«. (PMBOK, 2004). 

Začasno pomeni, da je projekt definiran z začetkom in koncem. Slednji je dosežen, ko so 

izpolnjeni vsi zastavljeni cilji, s tem pa projekt neha obstajati. Trajanje projekta je odvisno od 

zahtevnosti in obsega, ter ga je možno dokončati hitro ali pa se zaključi v nekaj letih, lahko pa 

tudi v nekaj desetletjih. Začasnost je povezana tudi z zahtevami na trgu, ki pogosto narekujejo 

tempo izvedbe. 

 

Projekt vsebuje nekatere elemente, ki se od prejšnjih projektov lahko razlikujejo po načinu, času, 

a tudi po okolju izvedbe. Torej zahteva določene raziskave in razvijanje tehnologije, kar daje 

projektu enkratnost in edinstvenost.   

 

»Projekt je enkratna, praviloma zahtevna in kompleksna skupina nalog, ki more biti končana v 

določenem roku, doseči mora vnaprej določene in morebitne kasneje odkrite cilje, ter upštevati 

vse podane in kasneje odkrite omejitve«. (Solina, 1997) Zaradi zahtevnosti projekta se vanj 

vključuje veliko število različnih strokovnjakov z različnih področij, ki morajo obvladovati 

tehnologijo in se držati okvira predvidenih stroškov, časa in kakovosti. 

 

Enkratnost in neponovljivost lahko opazimo, če primerjamo projekt in delo v proizvodnji. Oba 

načina dela imata nekaj skupnih lastnosti, npr.: potrebujeta ljudi, sta omejena s sredstvi, 

planiramo ju in kontroliramo. Največja razlika s proizvodnjo je ta, da ima slednja ponavljajoče 

faze in operacije, ki so si vedno zelo podobne.  

 

Projekt mora obravnavati serijo aktivnosti in nalog, ki imajo (Kerzner, 2003): 

• določene cilje za njihovo dokončanje, 

• definirane začetne in končne datume, 

• določene omejitve, 

• opredeljene potrebne človeške in druge vire. 
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Prednosti vodenja projekta so: 

• ugotavljanje omejitev terminskega plana, 

• merilo izvedenega proti planiranem, 

• pravočasno prepoznavanje problemov in ukrepanje, 

• optimalnejše prihodnje planiranje, 

• zavedanje o uspehu ali neuspehu ciljev,  

• zmanjševanje potrebe po stalnem poročanju. 

 

Pri uspešnem vodenju moramo za doseganje ciljev znati premostiti naslednje ovire: 

• kompleksnosti projekta, 

• uporabnikove posebne zahteve in spremembe v obsegu del, 

• organizacijsko prestrukturiranje, 

• tveganja na projektih, 

• tehnološke spremembe, 

• vnaprejšnje planiranje in ocenjevanje stroškov. 

 

Pod izrazom vodenje razumemo planiranje, organiziranje, vodenje in kontroliranje projekta. 

Vodenje projektov pomaga pri doseganju boljše izrabe posameznih virov. Pomemben element 

uspešnega vodenja je tudi razpoložljivost funkcionalnega osebja, ki je dodeljeno specifičnemu 

projektu. (Kerzner, 2003) 

 

Vodenje je v podjetjih ponavadi zasnovano kot horizontalno in večnivojsko. Podobnost se 

pojavlja vertikalno med delujočimi enotami v organizaciji – oddelkih. Če ti dve razporeditvi 

združimo, lahko vidimo, da je podjetje sestavljeno iz večih enot, ki tvorijo sistem organizacije 

(Slika 1). ( Kerzner, 2003)  

 

              

Slika 1: Sistem organizacije (Kerzner, 2003)  

Nivoji vodenja Funkcijska delitev: 
oddelki 

Sistem organizacije 

+ = 
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Čim boljše je sodelovanje in komunikacija v sistemu, boljši so rezultati dela ter uspešnejše je 

podjetje.  

 

2.2 Definicija uspešnosti projekta 

 

Cilj uspešnega vodenja projekta je planiranje oziroma kontroliranje virov v taki meri, da so 

znotraj zastavljenega okvira časa, stroškov in izvedbe. Poleg teh treh omejitev je za uspešnost 

projekta potrebno še dobro sodelovanje s končnim uporabnikom – stranko (Slika 2).  

                                   

                                                          

Slika 2: Pomembni faktorji pri vodenju projektov (Kerzner, 2003) 

 

Pomembno se je držati tudi: 

• minimalnih ali vzajemnih dogovorov o spremembi obsega - v veliko projektih se med 

izvedbo spremenijo cilji in obseg dela, kar ima za posledico dražjo izvedbo. Vodenje 

projekta mora imeti čim manjši vpliv na omenjene spremembe, če pa so potrebne, se 

morata o tem dogovoriti vodja projekta in stranka, 

• da se ne moti glavnega delovnega poteka v organizaciji - vodenje določenega projekta ne 

bi smelo iti iz okvira postopkov, politike vodenja in pravil ter direktiv podjetja, 

• da se ne spreminja kulture podjetja – projekt naj bi bil sledil temeljni kulturi, ki jo ima 

vsako podjetje. Če je vodilo podjetja zadovoljstvo strank, morajo biti projekti vodeni na 

način, da se to uresniči. 

 

 

 
 

VIRI 

ČAS STROŠKI 

IZVEDBA/TEHNOLOGIJA 

SODELOVANJE Z 
UPORABNIKOM 
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2.3 Vloga vodje projekta 

 

Naloga vodje projekta je s pomočjo razpoložljivih virov ustvariti končni proizvod, ki bo imel 

večstranske koristi za podjetje in uporabnike. Pri tem nam je v pomoč integracijsko vodenje in 

upravljanje, ki se ukvarja predvsem z obvladovanjem projekta kot celote, saj je v dele projekta 

nemogoče posegati, ne da bi pri tem neposredno vplivali na projekt kot celoto. 

 

Integracijske aktivnosti zajemajo: 

• izdelavo projektnega plana, 

• izpolnitev plana, 

• popravke plana. 

Integracija, za katero je zadolžen vodja projekta, je prikazana na sliki 3.  

 

                          

Slika 3: Integracijsko vodenje projektov (Kerzner, 2003) 

 

Če hoče biti projektni vodja uspešen pri integracijskem vodenju, mora imeti dobre 

komunikacijske sposobnosti in sposobnosti za dobre medosebne odnose. Prav tako pa mora 

poznati delovanja in postopke v sami organizaciji ter razumeti potrebno tehnologijo v procesu.  

Projektni vodja tako nastopa v vlogi povezovalca med organizacijami, vodstvom in naročnikom. 

 

2.4 Življenjski cikel projekta 

 

Življenjski cikel projekta je sestavljen iz faz, ki povezujejo njegov začetek in konec. (PMBOK, 

2004) Razumevanje posameznih faz pripomore k bolj uspešnemu nadzoru nad razpoložljivimi 
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viri in k doseganju željenih ciljev. Obstaja kar nekaj opredelitev faz življenjskega cikla, kar je 

razumljivo glede na kompleksnost in raznolikost projektov.  

 

Običajno življenjski cikel definira (PMBOK, 2004): 

• kakšno tehnično delo je potrebno opraviti v posamezni fazi, 

• kdaj je potrebno priskrbeti vire, 

• kdo je udeležen v projektu, 

• kako kontrolirati posamezne faze. 

 

Večina življenjskih ciklov projekta imajo skupne značilnosti: 

• stroški in potrebno število osebja je na začetku projekta majhno in raste do vrha, kjer se 

nato proti koncu projekta postopno zmanjšuje, 

 

                             

Slika 4: Potrebe po osebju in stroški, ki nastajajo skozi življenjski cikel projekta (PMBOK, 2004) 

 

• tveganje in negotovost je na začetku projekta večja in pada proti njegovemu zaključku, 

verjetnost dokončanja pa raste od začetka projekta,  

• vpliv vodstva na končne karakteristike je na začetku projekta velik in pada s časom. 

(razlog je v vse večjem vložku v projekt in s tem povezanimi velikimi sredstvi za 

morebitne spremembe). 
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Slika 5: Vpliv vodstva na projekt (PMBOK, 2004) 

 

Teoretično se faze imenujejo in si sledijo kot (Kerzner, 2003): 

• zasnova, 

• planiranje, 

• preverjanje, 

• realizacija, 

• zakjučevanje. 

 

                                           

Slika 6: Interakcija posameznih faz na projektu (PMBOK, 2004) 

 

V fazi zasnove so predvidene ocene glede ciljev projekta projekta. Pomembno je napraviti 

predhodne analize tveganja, predvideti časovni in stroškovni okvir ter preučiti zahtevano izvedbo. 

Faza planiranja bolj natančno definira čas trajanja projekta, njegov strošek in izvedbo. V tej fazi 

je prav tako predvidena začetna priprava na projektno dokumentacijo. 
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V fazi preverjanja je pripravljena skoraj vsa projektna dokumentacija, ki je potrebna za 

realizacijo. 

 

Zadnja faza – zaključevanje – vsebuje predajo produkta končnemu uporabniku ter 

prerazporeditev virov na nov projekt, ki je potreben za vzdrževanje nivoja prihodkov podjetja.  

 

2.5 Deležniki na projektu 

 

Deležniki na projektu so posamezniki in organizacije, ki so aktivno vpleteni v projekt ali pa jih 

zanimajo cilji oziroma dokončanje projekta. Naloga vodje projekta je prepoznati deležnike na 

projektu, ugotoviti njihove želje, potrebe in zahteve ter jih voditi do doseženega cilja. Različni 

deležniki imajo različne odgovornosti in avtoritete, saj delujejo na večih nivojih, od priložnostnih 

pomoči do finančne ali politične podpore.  

 

Glavni udeleženci na projektu so (PMBOK, 2004): 

• vodja projekta – odgovoren za vodenje projekta, 

• stranka/uporabnik – posameznik ali organizacija, ki bo produkt uporabljala, 

• izvajalsko podjetje – organizacija, katere zaposleni so najbolj udeleženi v procesu dela, 

• projektna skupina – skupina, ki opravlja delo na projektu, 

• sponzor – posameznik ali skupina, ki projektu priskrbijo finančna sredstva, 

• deležniki – posameznik ali organizacija, ki ni povezana s cilji ali namembnostjo projekta, 

vendar ima lahko nanj velik vpliv (v pozitivnem ali negativnem smislu). 

 

Vodje projekta morajo obvladovati pričakovanja udeležencov, kar pa ni vedno lahka naloga, saj 

so cilji glede projekta za vsakogar drugačni.  

Odvisnost med projektno skupino in deležniki je prikazana na sliki 7. 
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    Slika 7: Odnos med deležniki projekta (PMBOK, 2004) 

 

2.6 Projektna komunikacija 

 

Komunikacijski problemi so lahko osnovni razlog za neuspeh projekta, nerazumevanje med 

udeleženci na projektu pa lahko privede do konfliktnih razmerij v skupini. Že v domačem okolju, 

krogu družine in znancev se ljudje pogosto soočajo s slabim sporazumevanjem, ko pa se na 

projektu srečajo ljudje, ki se od prej ne poznajo, so lahko komunikacijeke ovire lahko toliko 

večje. Faktorji, ki vplivajo na komunikacijo na projektu, so udeleženci, sporazumevanja, okolje 

in jezik. Najšibkejši člen med njimi pa določa uspešnost rezultatov (Slika 8). 

 

 

   Slika 8: Model komunikacije za projektno vodenje (Forsberk, Mooz, Cotterman, 2005) 

 

Komuniciranje na projektih zahteva fleksibilnost in prilagodljivost v procesu razporejanja 

aktivnosti, vpletenega osebja, dogodkov ter situacij. Berlov model recimo omenja odnos (angl. 
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attitude) kot enega od petih značilnosti, ki določajo človekovo komunikacijo (preostale so 

komunikacijske sposobnosti, znanje, družbeni sistem in kultura).  

 

Za vodja projekta je zelo pomembno, da je v stalnem stiku s projektno skupino. Za komuniciranje 

med projektno skupino je primerna tehnika »vodenje z obhodi« (angl. Management-by-walking-

around). S takim načinom lahko vodja projekta prepreči ali pa vsaj zazna nekatere stvari, ki bi 

lahko v prihodnosti postale problem. Po drugi strani pa se s takim načinom vodenja krepijo vezi 

med sodelujočimi in v njih spodbudi pripadnost skupini, kar ima tudi pozitivne posledice na 

projekt.  

Pri komunikaciji s projektno skupino je dobro upoštevati vodilo, ki pravi »manj je več«. To 

pomeni, da mora biti vodja pri dajanju navodil jasen in kratek. Učinkovitost sestankov ponavadi 

ni odvisna od dolžine njegovega trajanja, saj poslušalcu lahko začnejo uhajati misli. Anatole 

France pravi, da v takih primerih »več kot govoriš, manj si ljudje zapomnijo«. Koliko si lahko 

zapomnimo, če poslušamo določeno časovno obdobje, si oglejmo spodaj (Forsberk, Mooz, 

Cotterman, 2005): 

• slišimo polovico od tega, kar je povedano – 2 uri, 

• poslušamo polovico, kar slišimo – 1 ura, 

• razumemo polovico kar poslušamo – 30 minut, 

• verjamemo polovici kar razumemo – 15 minut, 

• zapomnimo si polovico, čemur verjamemo – 8 minut. 

Velik problem dolgotrajnih sestankih je tudi utrujenost in s tem povezan padec koncentracije, kar 

vpliva na pozornost udeležencev. 

 

Sestanki in dogovori ne smejo delovati enostransko, saj je uspešen sestanek tisti pri katerem 

vodja dobiva sprotne odzive – povratne informacije – na svoje zahteve. S tem dobi pritrditev, da 

je bil jasen in so ga udeleženci tudi razumeli. Čim hitrejši je odziv, tem hitrejše je lahko tudi 

sprejemanje odločitev.  

Navodila in odzivi so lahko (Forsberk, Mooz, Cotterman, 2005) 

• učinkovita: 

� odkrita in objektivna, 

� specifična in popolna, 

� uresničljiva, 

� na podlagi dejstev, 
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� pravočasna. 

 

• neučinkovita: 

� čustvena in osebna, 

� splošna in nejasna, 

� neuresničljiva, 

� na podlagi mnenja, 

� nepravočasna. 

 

Različne oblike vpletenosti zahtevajo raznolike sposobnosti, ki jih mora imeti sodelujoči. Pri 

pasivnejši oziroma bolj zadržani obliki – pogovarjanju – je možnost nastanka konflikta majhna, a 

se moramo zavedati, da je s tem pogojen tudi vpliv. Pri svetovanju pa gre za veliko vključenost 

pri vplivanju, s tem pa so povezane tudi večje možnostim za nastanek spora. V takem primeru so 

potrebne zelo dobre komunikacijske spretnosti (Slika 9). 

 

              

Slika 9: Vpliv povratnih informacij (Forsberk, Mooz, Cotterman, 2005) 

 

Dobro komunikacijo in pridobivanje povratnih informacij spodbuja tudi okolje, v katerem 
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načinom sporočanja, da ne bi vznemirili sprejemnika, to pogosto privede do upočasnitve pretoka 

informacij. Sprejemniki naj bi zato pri sebi razvili mehanizem nedotakljivosti, kar pomeni, da jih 

informacije ne bi smele čustveno opredeljevati. 

 

Oblika organizacijske izoliranosti se v žargonu imenuje »silosi« (Silka 10), kar je lahko dodatni 

razlog, da komunikacija ne poteka tekoče. »Silosi« delujejo kot neke vrste pregrade, ki 

razmejujejo funkcijske oddelke med seboj. Vzrok temu je lahko zavest posameznih oddelkov o 
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večji teži in zaslugi za delovanje podjetja. Tako okolje pogosto deluje destruktivno in ne more 

voditi do nadpovprečnih rezultatov.  

 

                                                           

  Slika 10: Organizacijska izoliranost (Forsberk, Mooz, Cotterman, 2005) 

 

2.7 Spretnosti vodenja projektov  

 

V zadnjih petindvajsetih letih so se pri učinkovitem vodenju spremenila tudi razmerja med 

spretnostmi (Slika 11), ki jih mora imeti vodja projekta. Včasih je lahko postal vodja projekta 

nekdo, ki je imel odlično tehnično znanje, da je obvladoval odločitve predvsem z vidika 

tehnologije. Danes so projekti postali precej obsežni, s tem pa tudi bolj kompleksni. Za njihovo 

obvladovanje z vidika vodje projekta – v tehnološkem smislu – je potrebno zgolj razumevanje 

tehnologije in ne njeno narekovanje. Osnovne znanja in veščine vodje projekta v enaindvajsetem 

stoletju so tako (Kerzner, 2003): 

• poslovna znanja, 

• obvladovanje tveganja, 

• integracijske sposobnosti. 

                                        

Slika 11: Znanja in veščine vodenja projektov (Kerzner, 2003) 
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Prav obvladovanje tveganja naj bi v veliki meri prispevalo k boljšim končnim rezultatom. S to 

metodologijo je namreč možno pravočasno ugotoviti vzroke za nastanek izgub in jih tudi 

odpraviti.  

Dejstvo je, da so današnje potrebe in pričakovanja naročnikov vedno večje. To pa pomeni, da 

morajo tudi podjetja težiti k prilagajanju kupcem. S pomočjo obvladovanja tveganja in tehnične 

usposobljenosti jim to lahko uspe. (Slika 12) 

 

                  

    Slika 12: Koristi obvladovanja tveganja (Kerzner, 2003) 
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3 OBVLADOVANJE TVEGANJA 

 
 

Mnoga podjetja so v današnjem času na negotovi poti obstoja, ker jim ne uspeva prepoznavati in 

obvladovati tveganj, ki se pojavljajo in razvijajo vzporedno z hitrim razvojem trga in konkurence. 

Prav zadnje v veliki meri sili podjetja k sprejemanju še bolj tveganih odločitev, pri katerih je 

izvor negotovosti v poslovnem okolju podjetij, tehnoloških omejitvah in v človeškem dejavniku. 

Vse organizacije, ki se borijo za obstanek na tržišču, morajo imeti razvite mehanizme 

obvladovanja tveganja, zato je doslednost in celovitost pristopa odločilnega pomena. 

 

3.1 Upravljanje s tveganjem kot način vodenja projekta 
 

Negotovosti so prisotne pri vsakem gradbenem projektu in so glavni »krivec« za zahtevnost 

upravljanja s projektom. Bistvena naloga upravljanja s projektom je dejansko izvajanje dveh 

tipov del (Carter, 1994): 

• izvajanje plana – administracija in 

• upravljanje s tveganji. 

 

Prva aktivnost je pomembna za nemoten potek programa, medtem ko druga zagotavlja uspešnost 

projekta. Prav zaradi tega je potrebno tveganje obravnavati enakovredno kot plan projekta, kar 

pomeni, da postane upravljanje s tveganjem način vodenja projekta (risk-driven project 

management). Upravljanje s tveganji ne more biti ločena aktivnost, ampak mora biti v celoti 

integriran v procesu upravljanja s projektom.  

 

Pomembno je, da se temeljni cikel aktivnosti ponavlja tekom projekta. Vsak korak je sestavljen iz 

večih procesov. V preglednici 1 je razvidna kombinacija med aktivnostmi upravljanja s 

projektom in upravljanja s tveganjem ter njune sekvence. 
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    Preglednica 1: Kombinacija aktivnosti upravljanja s projektom in upravljanja s tveganjem (Carter, 1994) 

Faze aktivnosti Aktivnosti upravljanja s 
projektom 

Aktivnosti upravljanja s tveganjem 

Analiza • potrebne analize 
• realizacija FBS 
• realizacija WBS 
• realizacija PBS  

 
• vrednostne ocene (value analysis)* 
• analize aktivnosti 
 
• varnostne in zanesljivostne študije* 
• analiza omejitev* 
• identifikacija tveganj 
• dokumentacija tveganj 

Ocena  
 
• stroškovna in časovna ocena ter 

ocena porabe materiala 
• glavni plan realizacije 
• konsolidacija s tveganji 
• prvi koncept proračuna 
• analiza toka finančnih sredstev 

(Cash flow analysis) 

• kvantifikacija tveganj 
• klasifikacija tveganj 

Planiranje 
odziva  

• realizacija OBS 
 
 
 
 
• tabeliranje 
• realizacija projektnega plana 
• budgeting 
 
 
• definicija poročila 

• lastniki tveganj 
• analiza datumov tveganj* 
• ublažitev tveganj 

-strategije 
-planiranje 

 
 
 
• fond za tveganje 
• odločanje 

Spremljanje • spremljanje definiranih 
indikatorjev 

• kontrola napredka 
 
• poročilo 

 
 
 
• poročilo tveganj 

         * neobvezne aktivnosti 
 
Gradbeništvo ima na splošno slabo reputacijo glede tveganja pri prekoračitvah stroškov in rokov. 

Poročilo Svetovne banke iz leta 1990 (World Bank, 1990) potrjuje povprečno 40% prekoračitev 

začetnih stroškov v 63% od vsega 1778 financiranih projektov, oziroma povprečno 70%-tno 

prekoračitev začetnega časa v 88% od vsega 1627 projektov v obdobju zadnjih petnajstih let. 

Številne druge raziskave kažejo na delovanje množice vplivnih faktorjev na spremembe ciljev 

projekta. Na denarne in  časovne cilje projektov deluje niz spremenljivk tveganja, ki neprekinjeno 

povzročajo deviacije od začetnih programiranih vrednosti.  
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Rezultati raziskovalne naloge (Raziskovalna naloga, 2000), v kateri so vsebinsko in statistično 

obdelali 100 projektov nizke gradnje, kažejo, da med opazovanimi projekti skoraj ni takšnih brez 

prekoračitve stroškov (precej tudi nad 50%), pretežni delež projektov pa tudi prekoračuje 

postavljene roke. 

 

Prav zaradi tega je upravljanje s tveganjem še toliko bolj pomembno in je smiselna uporaba 

metodologije, ki bi zmanjševala vpliv tveganja na projektu.  

 

3.2 Opredelitev in cilji obvladovanja tveganja 

 

Opredelitev načina obvladovanja tveganja za podjetja ni enostavna naloga. Raziskava Best 

Practice in Risk Management: Privat and Public Sectors Internationally, ki jo je leta 1999 izvedla 

kanadska svetovalna agencija Canadian Treasury Board, navaja sledeče najboljše načne (Berk, 

Peterlin, Ribarič, 2005): 

 

• izoblikovanje organizacijske kulture, kjer zaposleni intuitivno razumejo razmišljanje 

vodstva o tveganju in ciljih, ki naj bi jih prineslo njegovo obvladovanje, 

• zagotovitev stanja, ko vodstvo pripisuje obvladovanju tveganja velik pomen in skrbi za 

zadovoljivo komuniciranje glede sprejemljivih stopenj tveganja, 

• vzpostavitev komunikacije, ki daje napotke za prepoznavo posameznih vrst tveganja in 

sprejemanja primernih ukrepov, 

• izoblikovanje formalnih in neformalnih timov za presojanje različnih nagnjenj k tveganju 

in pogledov na obvladovanje tveganja, 

• uporaba skupne terminologije za obravnavanje tveganja, 

• vzpostavitev centra odgovornosti za obvladovanje tveganja, 

• razkrivanje glavnih zaznanih tveganj in načinov ter učinkovitosti njihovega obvladovanja 

lastnikom in drugim ključnim interesnim skupinam podjetja, 

• zagotovitev ustreznega nadzora postopkov obvladovanja tveganja in možnost za 

implementacijo nadzora prek aktivnosti interne revizije (kontrole), 

• vključitev izobraževanja o tveganju v programe usposabljanja zaposlenih, 

• razvoj specifičnih, čim lažje razumljivih metod in tehnik za obvladovanje tveganja. 
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Na vprašanje, kako pomembne so informacije in kdaj jih imamo dovolj, da bi na podlagi njih 

lahko odločali, slikovito odgovarja Colin L. Powell, nekdanji ameriški državni sekretar. Predlaga, 

da je pri odločitvah koristno uporabiti formulo 40/70 in svetuje: »Ne sprejemajte odločitev, če 

nimate dovolj informacij oziroma je verjetnost, da bo odločitev povzročila ugodne posledice, 

manj kot 40-odstotna. Velja tudi nasprotno. Ne čakajte namreč trenutka, da boste stoodstotno 

prepričani, da ste na pravi poti, saj bo takrat odločitev sprejeta prepozno oziroma tega trenutka ne 

boste nikdar dočakali.« (Berk, Peterlin, Ribarič, 2005) 

 

3.3 Upravljanje s tveganjem 
 

Ko je bil projektni menedžment šele na začetku oziroma so se podjetja z njim začela spoznavati 

in ga uvajati v proces poslovanja, je večina projektnih odločitev težko ustregla optimalni 

razporeditvi virov in njihovi ugodni ceni. 

 

Danes imamo na trgu množico možnosti za uporabo različnih tehnologij gradenj, ki se iz dneva v 

dan dopolnjujejo in razvijajo. Pri projektih, ki trajajo manj kot eno leto, predpostavljamo da je 

tehnološko okolje poznano in varno. Kaj pa pri projektih, ki trajajo več let? Te moramo še 

posebej pretehtati in preučiti. 

 

Proces upravljanja s tveganjem v projektu naj ne bi samo prepoznaval tveganja, ampak bi moral 

tudi vključevati planiranje aktivnosti, analiziranje ocen in napovedovanje vpliva tveganja na 

projekt ter možnost opazovanja napredka v zmanjševanju obravnavanih tveganj. (Krezner, 2003)  

 

Projekt je po definiciji nekaj neponovljivega in enkratnega, tako se z njim nismo mogli srečati v 

preteklosti, prav tako pa ga ne bomo nikoli več v prihodnosti. Zaradi teh posebnosti moramo 

razviti odnos do tveganja in ga sprejeti kot del poslovanja. Ob neponovljivosti so možna tveganja 

večja kot pri ponavljajočih se procesih. 

 

Upravljanje s tveganjem je posebno pomembno, ko obstaja nevarnost negotovosti in nas tako 

osredotoči na prihodnost ter pomaga razvijati ustrezne plane, da bi se izognili potencialnim 

problemom.     
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3.4 Negotovost, tveganje in njihovo upravljanje 

 

Prednost, ki jo lahko izkoristimo na začetku vsakega projekta, je njegovo definiranje, pri tem pa 

si lahko pomagamo s sledečimi vprašanji (Chapman, 1997): 

• kdo - zanima nas, kdo so udeleženci, ki so neposredno vpleteni pri projektu, 

• zakaj - motivi udeležencev, 

• kaj -  kaj bomo naredili v okviru projekta, 

• kako - kako bo projekt potekal, 

• kje in s čim - kateri viri so potrebni, 

• kdaj - kdaj mora biti projekt zaključen. 

 

Ta vprašanja nas opomnijo na šest vsebinskih sklopov, ki se jih moramo zavedati tekom trajanja 

celotnega projekta. Posebej pa so koristna na začetku, ker nas seznanijo oziroma nas pregledneje 

vodijo skozi interese udeležencev v projektu. 

V kakšni povezavi so področja, si lahko ogledamo na sliki 13. 
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Slika 13: Šest vprašanj (Chapman, 1997) 

 

Največja negotovost se pojavi v začetni fazi projekta, to je v zasnovi, ko še niso natančno jasni 

potreba in namen projekta ter njegovi udeleženci. Načeloma se velik del negotovosti zmanjša v 

fazi načrtovanja in planiranja z navajanjem, kaj je potrebno narediti, kako, kdaj, kdo so izvajalci 

ter kakšna je končna cena.  

Projektni pobudniki skušajo v začetku ugotoviti, kakšen je namen projekta oziroma kakšne bodo 

njegove končne koristi, prednosti in kaj so motivi za njegovo uresničitev. Slednji ponavadi 

pomenijo dobiček in prihodek, vendar lahko poleg teh obstajajo še drugi motivi.   
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3.5 Definicija tveganja 

 

S tveganjem se človek srečuje vsakodnevno na vseh področjih. Pri tveganju gre za verjetnost, da 

bo realizacija nekega dogodka odstopala od našega pričakovanja glede končnega izida. S tem 

imamo v mislih, da je lahko končni odklon v pozitivnem ali negativnem smislu. Pri poslovnih 

odločitvah bi nas morali najbolj zanimati dogodki, ki bi prinesli izgubo v širšem smislu: lahko je 

to manjši dobiček od pričakovanega, slaba prodaja, neizpeljanje projekta do konca zaradi 

različnih dogodkov...  

 

Različni avtorji definirajo tveganje na različne načine. Navedimo nekaj definicij iz literature: 

  

»Tveganje je merilo verjetnosti za nedoseganja zastavljenih ciljev projekta« (Kerzner, 2003)   

  

»Tveganje je negotova situacija, v kateri se lahko pojavi večje število izidov, od katerih je eden 

ali več nezaželenih« (Merkhofer, 1987)  

 

Vaughan (Berk, Peterlin, Ribarič, 2005.,Vaughan, 1997) omenja: 

• da je tveganje povezano z verjetnostno porazdelitvijo poslovnih dejanj, 

• da nekateri izidi poslovnih dejanj povzročajo podjetjem nezaželeno izgubo. 

 

Dorfman (Berk, Peterlin, Ribarič, 2005., Dorfman, 1996) opredeli izgubo kot »vsakršno 

nezaželeno zmanjšanje gospodarske koristi podjetja«, medtem ko Bitz dodaja, da je »tveganje 

posledica porazdelitve negotovih dogodkov v prihodnosti in tudi posledica nepopolnih ali 

nekakovostnih informacij, ki jih vodstvo uporablja za sprejemanje poslovnih odločitev«. (Berk, 

Peterlin, Ribarič, 2005., Blitz, 2000) 

 

»Pri negotovost pa je drugače – odločevalec namreč o pojavu nima vedenja in verjetnostne 

porazdelitve ne zna smiselno oceniti. Kdor se odloča v razmerah negotovosti, ne more sklepati o 

uspešnosti svojih dejanj vnaprej, prav tako pa tudi odločitev ne more presojati v skladu s 

profilom nagnjenosti k tveganju«. (Berk, Peterlin, Ribarič, 2005) 

 

Tveganje ima (Kerzner, 2003) dve primarni komponenti. To sta: 

• verjetnost pojava neugodnega dogodka in 
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• vpliv neugodnega dogodka.  

 

Tveganje = f (verjetnost, vpliv) 

 

V splošnem velja, če narašča verjetnost dogodka in njegov vpliv narašča tudi tveganje. Zato 

morata biti oba zajeta oziroma obravnavana s strani upravljanja s tveganjem. Za lažjo predstavo 

si poglejmo sliko 14. 

 

                            

Slika 14: Komponente tveganja (Kerzner, 2003) 

 

Naslednji element tveganja je njegov vzrok, ki ga lahko imenujemo tudi hazard. Nekateri hazardi 

so lahko v veliki meri obvladljivi, če smo na njih opozorjeni oziroma jih poznamo (Kerzner, 

2003). Vzemimo za primer avto in njegove gume, ki nimajo zadostnega profila, da bi bile lahko 

varne na cesti. Če se tega zavedamo oziroma nas je vulkanizer pravočasno opozoril na nevarnost, 

lahko morebitno nesrečo v prihodnosti tudi preprečimo.  

 

Kerzner nam tako predstavi še eno obliko: 

 

 tveganje = f(hazard, obvarovanje) 
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To pomeni, da tveganje narašča tudi s hazardom in se zmanjšuje z obvarovanjem pred njim. Torej 

bi morali z dobrim obvladovanjem tveganja razkrivati oziroma prepoznavati hazarde in se znati 

pravočasno obvarovati pred njimi. 

 

3.6 Proces upravljanja s tveganjem 

 

Ob začetku novega projekta naj bi podjetje razvilo strategijo upravljanja s tveganjem na ravni 

projekta, kar mora biti v skladu s strategijo upravljanja s tveganjem na ravni podjetja. Taka 

strategija zmanjšuje tveganja in poskrbi za njegovo nenehno obravnavanje in nadzorovanje. Cikel 

upravljanja s tveganjem sestoji iz naslednjih faz (Ralph, Irwin, 1997): 

 

• Identifikacija tveganja, ki je neke vrste raziskava v zgodnji fazi projekta. Pod raziskavo je 

mišljen pregled projektnih planov, razgovor z udeleženci na projektu, izračun statistik in 

količin ter skrben pregled tehnične dokumentacije.   

 

• Analiziranje tveganja je faza, ko na podlagi pridobljenih podatkov med identifikacijo 

tveganja pridemo do informacij za nadaljevanje projekta. Obstajata dve kategoriji 

analiziranja tveganja: kvantitativna (simulacija Monte Carlo) je statističen pristop in 

kvalitativna, ki temelji bolj na presoji.  

 

• Kontrola tveganja pripomore k zmanjšanju oziroma izognitvi neugodnega vpliva tveganja 

na proces projekta. Obstajata dve možnosti pri kontroli tveganja: prva je reaktivna, kar 

pomeni da na neugoden trenutek čakamo in posredujemo šele ob njegovem nastanku. 

Druga možnost se imenuje proaktivna, kjer ukrepamo preventivno, torej vzpostavimo 

varovalni mehanizem pred nastopom neugodnega dogodka. 

 

• Poročilo o tveganju predstavlja zadnjo fazo in je neke vrste zaključek cikla. Poročilo 

lahko nastopa v obliki dokumenta ali predstavitve pred kolegi in je hkrati obrazložitev 

oziroma opozorilo glede tveganj, s katerimi se lahko srečajo v prihodnosti.  

 

Bolj ko upoštevamo in se držimo zaporedja navedenih korakov, ki skupaj tvorijo cikel  

upravljanja s tveganjem, boljši so končni rezultati, začetna pričakovanja se na koncu izkažejo za 
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točnejša in večje je naše zadovoljstvo ob končanju projekta. Grafično je Demingov krog 

obvladovanja tveganj (imenovan po W. Edwards Demingu) prikazan na  sliki 15. 

 

                       

Slika 15: Demingov krog (Ralph, Irwin, 1997) 

 

3.7 Identifikacija tveganja 

 

V tej fazi natančno preučimo projekt, da bi zmanjšali tveganja in njegove komponente (Ralph, 

Irwin, 1997). Zato se moramo držati naslednjih točk: 

 

3.7.1 Identificiranje najpomembnejših udeležencev 

 

Vodja projekta mora poleg zbiranja ustreznih informacij za zmanjševanje tveganja pozornost 

posvetiti tudi kadru, ki bo udeležen pri projektu. Izbral naj bi ljudi, ki dobro obvladajo poslovni 

in tehnični vidik projekta za soočenje s tveganjem, prav tako pa morajo imeti dobre 

komunikacijske spretnosti ter dober »posluh« za skupinsko delo. Prav te sposobnosti so bistvene 

za izmenjavo informacij in prepoznavanja tveganj. Za zadnje je značilno, da so produkt dobrega 

sodelovanja večih posameznikov in ne samo prizadevanj vodje projekta.  
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3.7.2 Zbiranje informacij 

 

Razumevanje komponent in ciljev projekta ter soočenje s tveganjem ni lahka naloga. Več 

informacij obvladujemo, boljše so narejene končne analize. Informacije so preoblikovani podatki 

in morajo biti relevantne, natančne, zaneslive in v obliki, ki služijo uporabniku. Če poznamo pot, 

ki nas pripelje do pravih informacij, pomeni, da se zavedamo njihove pomembnosti, torej vemo 

kje, kdaj in od koga jih bomo dobili. To pa zahteva dobro razumevanje ureditev, postopkov, 

organizacijskih struktur in informacijske arhitekture v podjetju. Viri, na podlagi katerih lahko 

pridobivamo informacije, so (Ralph, Irwin, 1997): 

� ocene stroškov in časa,  

� podatkovne baze, 

� realizacije planov, 

� organizacijske sheme, 

� projektna literatura, 

� projektni plani, 

� razporeditve virov, 

� izkaz posla, 

� statistike in meritve, 

� tehnična dokumentacija. 

 

3.7.3 Obravnava komponent tveganja 

 

Ko vodja projekta zbere informacije, lahko identificira komponente oziroma proces projekta in 

njegova tveganja, pri tem pa pogosto poskuša obravnavati vsak del posebej. Najboljša metoda 

obravnavanja je, da vodja projekta vidi posamezne dele kot vzajemne drug drugemu in ne na 

način, kot da so neodvisni oziroma se ne povezujejo. To nam prikazujejo Vennovi diagrami 

(Slika 16). 
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Slika 16: Prikaz odvisnosti komponent in tveganj s pomočjo Vennovih diagramov (Ralph, Irwin, 1997) 

 

3.7.4 Identificiranje povezanih tveganj 

 

Vodja projekta ima na izbiro dva pristopa, ki ju lahko izbere pri identificiranju komponent 

tveganja: prvi pomeni, da se vodja problema loti samostojno, pri drugem pa sodeluje celotna 

skupina.  

 

Pri samostojnem delu faza lahko traja nekoliko manj časa, vendar je možen pojav določenih 

pomanjkljivosti, ki sledijo iz ozke usmerjenosti, to pa lahko privede k škodnim domnevam. Da bi 

se temu izognili, nam pomaga (Ralph, Irwin, 1997):    

� križno preverjanje rezultatov, ki jih opravijo določeni strokovnjaki, 

� primerjanje rezultatov podobnih projektov,  

� uporaba tehnik kot so recimo viharjenje možganov (angl. brainstorming). 

 

Skupinsko delo ima nekaj prednosti v tem, da je rezultat identifikacije bolj uravnotežen in 

popoln. Pri dobrem vodenju skupine se bodo lažje izrazile domneve in ideje, ki so lahko koristne 

za razkritje določenih tveganj. Vseeno pa je mogoč pojav škodnih domnev in idej, ki so prav tako 

lahko izvor ozke usmerjenosti in jih lahko rešujemo na podoben način kot v prvem primeru. 
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3.7.5 Prednostno razvrščanje 

 

S trajanjem življenjskega cikla projekta se določena tveganja zmanjšujejo, vendar dobivajo na 

veljavi in vplivu nova. Potek nastajanja in zmanjševanja tveganja lahko vidimo na sliki 17.  

                                      

                                                                  

  Slika 17: Padanje vrednosti tveganja skozi življenjski cikel (Ralph, Irwin, 1997) 

 

Vzrok temu so okoliščine, ki v danem trenutku določeno tveganje izpostavijo, vendar v 

nadaljnem to isto tveganje ne predstavlja več nobene vrednosti. Za primer bi lahko vzeli, da se 

pred dobavo določenega materiala pojavlja verjetnost zamude, ki bi lahko ogrozila pravočasno 

dokončanje projekta. Ker pa z dobavo nismo imeli težav, se pojavi novo tveganje, ki lahko 

predstavlja slabo vgradnjo istega materiala. To pomeni, da je nujno spremljanje in obravnavanje 

tveganja v celotnem življenjskem ciklu projekta. 

 

3.8 Analiziranje tveganja 

 

Tehnike, ki nam lahko pomagajo pri analiziranju tveganja, so (Ralph, Irwin, 1997):  

� ocena treh spremenljivk (angl. three-point estimate), 

� drevo odločanja (angl. decision tree), 

� simulacija Monte Carlo, 

� hevrističen pristop. 
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       Preglednica 2: Prednosti in slabosti tehnik (Ralph, Irwin, 1997) 

Tehnika: Prednosti: Slabosti: 

Trismerna ocena • preprosta uporaba 

• hitro izračunavanje 

• subjektivna ocena, odvisna 

od sposobnosti ocenjevalca 

• ni potrebna baza podatkov  

• lahko pride do zmote zaradi 

nenatančne opredelitve 

Drevo odločanja • privede do verjetnosti 

različnih izidov 

• odločanje je stopenjsko 

• zaporedje dogodkov je 

lahko predstavljeno v obliki 

drevesnih vej 

• končna odločitev je odvisna 

od prejšnjih 

• je lahko nepopolna, če ne 

vsebuje nekaterih 

parametrov  

• lahko postane nepregledna, 

če se zelo poveča število 

dogodkov 

 

Simulacija Monte Carlo • računalniška simulacija 

• uporabna pri velikih 

projektih 

• postopek ni optimiziran 

• rešitev ni dokončna 

• vhodne podatke tvorijo 

naključna števila 

Hevrističen pristop • pravilo palca 

• sprejemljive rešitve 

• ne zagotavlja optimalne 

rešitve 

• rezultati temeljijo na 

subjektivnih ocenah in so 

približki 

 

3.8.1 Ocena treh spremenljivk 

 

Predstavlja tri spremenljivke: optimistično, pesimistično in najbolj verjetno. Te so osnova za 

izračun željenih vrednosti. Za primer lahko vzamemo projekt, ki zamuja z določeno aktivnostjo 

mi pa bi radi izračunali kolikšen čas je potreben za njegovo dokončanje. Optimistična napoved 

trajanja aktivnosti (To) je 7, pesimistična (Tp) 28 in najbolj verjetna (Tn) 11 dni. Pričakovano 

trajanje aktivnosti Tp izračunamo po formuli: 

 

Tp = ( To + ( 4 * Tn ) + Tp )/6                                                                              (1) 

Tp = ( 7 + ( 4 * 11 ) + 28 )/6 = 13,2 dni                                                                                     (2) 
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Ta vrednost predstavlja pričakovano trajanje aktivnosti.  

 

3.8.2 Drevo odločanja 

 

Drevo odločanja nam grafično pomaga pri povezovanju informacij in opisuje procese. Z njegovo 

pomočjo lahko izračunavamo verjetnosti posameznih dogodkov (Slika 18). Spodnji trije koraki 

nam pomagajo pri načrtovanju drevesnega diagrama (Kerzner, 2003): 

 

� ponavadi začnemo z načrtovanjem od leve proti desni, vključno z vsemi 

odločitvenimi točkami, 

� verjetnosti posameznih možnosti vpisujemo na smernice, 

� dodamo vse pogoje, ki tvorijo mrežo (stroški, dobički, ...). 

 

                          

Slika 18: Drevo odločanja (Kerzner, 2003) 

 

Vzemimo, da je lahko izdelek narejen na stroju A s 40% verjetnostjo oziroma je narejen na stroju 

B s 60% verjetnostjo. Na obeh strojih je možno proizvajati po dveh procesih C in D z določeno 

verjetnostjo. Zanima nas, koliko je različnih kombinacij in s kolikšno verjetnostjo so izdelki 

proizvedeni. Dobimo: 

 

AC = 0,4 * 0,8 = 0,32 

AD = 0,4 * 0,2 = 0,08 

BC = 0,6 * 0,3 = 0,18 

BD = 0,6 * 0,7 = 0,42 
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Prav tako lahko uporabimo »drevesno tehniko« za bolj sofisticirane probleme. Tokrat smo v 

vlogi investitorja in nas zanima študija proizvajanja oziroma kupovanja istega izdelka za prodajo 

na trgu. Če hočemo sami proizvajati izdelke, potrebujemo stroj, zanj pa moramo odšteti 35,000 

EUR. Zaslužek bo ob dobri prodaji znašal 80,000, ob slabi pa 30,000 EUR, toda brez upoštevanja 

nakupa stroja. Lahko se odločimo za manj tvegano odločitev in izdelke kupimo od dobavitelja, ki 

nam pri tem zaračuna 5,000 EUR. Tu bo zaslužek nekoliko nižji in bo znašal 50,000 EUR ob 

dobri ter 15,000 EUR ob slabi prodaji. Ponazorimo proces z našo metodo (Slika 19).  

 

                    

Slika 19: Razširjen drevesni diagram (Kerzner, 2003) 

 

Pričakovana vrednost znaša v prvem primeru 65,000 EUR od nje pa moramo odšteti še 35,000 

EUR za nakup stroja, tako je ostanek 30,000 EUR. V drugem primeru pa od pričakovane 

vrednosti 39,500 EUR odštejemo 5,000 EUR in ostane 34,500 EUR. Sedaj ni več dvoma o 

odločitvi med proizvodnjo in nabavo. 

 

3.8.3 Simulacija Monte Carlo 

 

Simulacija je namenjena reševanju problemov s področja negotovosti, samo ime pa izhaja iz 

podobnosti z igrami na srečo. Metoda Monte Carlo je stohastična, kar pomeni, da temelji na 

uporabi naključnih števil in verjetnostnih porazdelitev. Pri reševanju problemov izvajamo 

naključno vzorčenje množice elementov, pri katerem ima vsak element neko verjetnost, da je 

izbran. Osnovna značilnost Monte Carlo simulacije je modeliranje stvarnega sistema (problema) 

z eno ali več funkcijami verjetnostne porazdelitve, ki so dobljene iz eksperimentalnih podatkov. 
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Metoda je lahko uporabna pri nekaterih problemih, za katere ne obstaja nobena druga analitična 

rešitev, njena natančnost pa je sorazmerna s kvadratnim korenom števila izvedenih poskusov.  

Obnašanje matematičnega ali fizikalnega sistema opišemo s funkcijami verjetnostne porazdelitve 

za naključne spremenljivke X1, X2, … Xn. 

Rešitev problema je rešitev funkcije: 

  Y = g(X1, X2, … Xn). 

S simulacijo Monte Carlo določimo Y. 

Koraki, ki jih izvaja simulacijski model: 

� naključno generira (vzorči) vrednosti X1, X2, … Xn glede na funkcije 

verjetnostnih porazdelitev, 

� izračuna vrednost iskanega parametra Y = g(X1, … Xn), 

� N-krat ponovi prvi in drugi korak: večje ko je število ponovitev, bolj 

zadovoljivi bodo rezultati,  

� dobljene naključne vzorce, ki izhajajo iz poskusov, preračuna na končen 

statističen rezultat. Slednji je povprečje rezultatov posameznih poskusov, 

njegova napaka pa je varianca. 

 Postopek simulacije si lahko ogledamo na sliki 20.    

 

                                         

Slika 20: Postopek simulacije Monte Carlo                             

 
Logični model za 
iskanje funkcije Y 

Izračun vrednosti 
iskanega parametra Y 

Rezultat je 
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Vzorci Monte Carlo 

NE DA 
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3.8.4 Hevristični pristop 

 

Hevristični pristop je tisti, pri katerem se uporabljajo metode, ki niso dokazane, ampak so se 

razvile z metodo poskušanja in ugotavljanja. Rešitve takega pristopa so boljše kot popolnoma 

naključne ali nepreverjene, toda kljub temu ne zagotavljajo optimalnosti. Uporablja se takrat, ko 

ne obstaja nobena druga možnost ali tehnika za analiziranje tveganja. 

  

3.9 Kontrola tveganja 

 

Namen te faze je obravnavanje tveganja za čim boljše doseganje ciljev na projektu. Osebje, ki se 

srečuje z obravnavanjem strategij tveganja, bi si za oporo lahko pomagalo z naslednjimi vprašanji 

(Kerzner, 2003): 

• ali je strategija izvedljiva in hkrati zadošča uporabniku, 

• kakšen je pričakovan učinek zmanjševanja tveganja, 

• ali je strategija ekonomsko, časovno ali kako drugače upravičena,  

• ali imamo dovolj časa za razvoj strategije in kakšen učinek bo imela na celotnen terminski 

plan, 

• kakšna bo učinek na tehnično izvedbo. 

 

Opcije obravnavanja tveganja so lahko (Ralph, Irwin, 1997): 

• sprejemanje tveganja: pomeni, da projektni vodja ve za določeno tveganje, vendar ga ne 

poskuša odpraviti, 

• prevzemanje tveganja: pomeni, da projektni vodja ob zaznavi tveganja ukrepa in poskuša 

odpraviti škodne vplive na projekt, 

• izogibanje tveganju: projektni vodja ukrepa preventivno, kar pomeni, da pred nastopom 

tveganja preuči možnosti, iz katerih bi lahko sledila odstopanja od želenega,  

• prenos tveganja: tveganje se prenese na drugo osebo bodisi z zavarovanjem ali preko 

jamstva udeležencev. 
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Slika 21: Opcije tveganja (Kerzner, 2003) 

 

Vendar je tako obravnavanje tveganja še vedno bolj taktične narave in pri tem ne gre za 

strategijo, kako bi odpravili posamezen izvor tveganja. Pristop takega reševanja lahko označimo 

kot odzivni in pogosto pripelje do situacije, kjer je potrebno (Ralph, Irwin, 1997):  

• povečevanje števila ljudi, opreme, materiala in denarja, 

• prevzeti dodatne skrbi, 

• zamenjati določeno osebje, 

• preplaniranje ne glede na dolgoročne posledice, 

• imeti premajhen ali prevelik maneverski prostor, 

• takojšna odprava pomanjkljivosti. 

 

Da bi se takemu ravnanju v veliki meri izognili, moramo postopati s preventivnim načinom 

reševanja tveganja, kar pomeni, da bo projekt dosegel želene cilje. Preventivno torej pomeni 

izbrati primeren proces kontrole na začetku življenjskega cikla projekta, ker se vložek v 

kasnejšem obdobju povečuje (Slika 22) in predstavlja takratni padec projekta velik finančni 

udarec za investitorja. 

 

Z analiziranjem, prepoznavanjem in obvladovanjem tveganj na projektih lahko projektna skupina 

oblikuje strategijo, ki zagotavlja bolj uspešno izvedbo projekta. To pa lahko pomeni hitrejšo 

izvedbo, manj stroškov in bolj gladko izpeljavo.  

Tveganje je lahko identificirano na podlagi življenjskega cikla projekta. V začetnih fazah je 

skupno tveganje visoko, ker ne obstaja zadosti informacij o poteku projekta, vendar se s pravim 
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pristopom to lahko zmanjšuje v kasnejših fazah. S finančnim tveganjem pa je obratno, to je 

največje v zaključku, ko je celotni vložek v smislu sredstev najvišji. (Kerzner, 2003)  

 

                   

Slika 22: Tveganja v življenjskem ciklu projekta (Kerzner, 2003) 

 

Preglednica 3: Dejavniki tveganja, ki nastopajo v posameznih fazah (Kerzner, 2003) 

ODOBRITEV: NAČRTOVANJE: IZVEDBA: ZAKLJUČEK: 

• pomanjkanje 

strokovnjakov 

 

• slaba opredelitev 

problema 

 

• slaba študija 

projekta 

 

• nejasni cilji 

• brez načrta za 

obvladovanje 

tveganj 

 

• površno 

načrtovanje 

 

• slaba 

specifikacija 

 

• slabi opisi nalog 

 

• pomanjkanje 

podpore 

 

• slaba delitev 

vlog 

 

• neizkušenost 

• neusposobljena 

delovna sila 

 

• težave z dobavo 

materialov 

 

• stavke 

 

• vreme 

 

• sprememba 

obsega 

 

• sprememba 

časovnega načrta 

 

• zakonske 

zahteve 

 

• slaba kvaliteta 

 

• nesprejemljivost 

za kupce 

 

• težave z 

denarnim tokom 



KUHAR, Z. 2006. Obvladovanje tveganja na projektih s pomočjo programa MS Access.                                                                                  35                                                       
Dipl. nal. – UNI. Ljubljana, UL, FGG, Odd. za gradbeništvo, Prometna smer.    
 

tima • pomanjkanje 

nadzornih 

mehanizmov 

 

3.9.1 Uporaba učinkovitega opozorilnega sistema 

 

Za vodjo projekta lahko uporaba tega sistema pomeni ugotavljanje razlik med planiranim in 

izvedenim na področju stroškov ter terminskim planom. Ko se pojavi odstopanje v negativnem 

smislu, pomeni, da pri vodenju projekta niso v zadostni meri upoštevani dejavniki tveganja.  

 

Merilo časovnega odstopanja je razlika, ki se pojavi v spremljanju terminskega plana. Najbolj je 

občutljiva kritična pot, saj vsako podaljševanje trajanja aktivnosti na tej poti povzroči zamik 

predvidenega končnega roka projekta.  

 

Tudi razliko med predvidenimi in dejanskimi stroški moramo med projektom neprestano beležiti, 

ker je ta kazalec finančne uspešnosti projekta. Vodja projekta mora torej opazovati napredovanje 

projekta in hkrati zaznavati tveganja. Pri tem mu pomaga prislužena vrednost (angl. earned 

value), ki je povezana z revizijo terminskega plana in stroškov za opravljeno delo. Poznamo tri 

spremenljivke, ki tvorijo prisluženo vrednost. Te so: 

� planirani stroški za planirano delo (BCWS), 

� planirani stroški za opravljeno delo (BCWP), 

� dejanski stroški opazovanega dela (ACWP). 

 

Z uporabo teh spremenljivk lahko izračunamo stroškovni odmik (angl. cost variance - CV) 

 

CV = BCWP – ACWP                                                                                                                   (3) 

in odmik terminskega plana (angl. schedule variance – SV) 

 

SV = BCWP – BCWS                                                                                                                    (4) 

 

Če sta obe izračunani vrednosti negativni, je potrebno natančno preučiti kaj so glavni vzroki za 

nastalo situacijo. V tem primeru je dobro preveriti aktivnosti na kritični poti, saj so te mnogokrat 

razlog za pojav različnih tveganj. 
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3.9.2 Sprejemanje metodologije projektnega vodenja 

 

Metodologija projektnega vodenja lahko pomaga, da se izognemo tveganju na področju vodenja, 

definiranja, planiranja, organiziranja, kontroliranja in zaključevanja projekta. Hkrati pa ima taka 

metodologija prednost zaradi standardiziranja pristopa k projektnemu vodenju in zato omogoča 

udeležencem nedvoumno komuniciranje. Če ljudje na projektu uporabljajo poenoteno obliko 

komuniciranja in poročanja, to ogomoča boljši pretok informacij in večje obvladovanje tveganja. 

Vse to pa vodi k boljši produktivnosti, po drugi strani pa k zmanjšanju kompleksnosti problema, 

zmede in konfliktnosti na projektu. Uspešna metodologija projektnega vodenja zajema vsebino iz 

preglednice 4.  

 

Preglednica 4: Vsebina tipične metodologije projektnega vodenja (Ralph, Irwin, 1997) 

VODENJE • komunikacija 

• nedvoumno usmerjanje 

• motivacija 

• podpora 

• timsko delo 

• vizija 

DEFINIRANJE • objava projekta 

• izkaz dela 

PLANIRANJE • ocene stroškov 

• ocene trajanja projekta 

• razpored virov 

• kontrola tveganja 

• terminski plan 

• ukrepanja proti nedoseganju ciljev 

ORGANIZIRANJE • avtomaticacija orodja 

• obrazci 

• podatkovne baze 

• spomini 

• procedure 

• projektne pisarne 

• poročila 

• organiziranost kolektiva 

• učinkovitost dela 

KONTROLIRANJE • korektivni ukrepi 
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• sestanki 

• preplaniranje 

• ocenjevanje stanja in beleženja 

ZAKLJUČEVANJE • nove ugotovitve 

• recenzija realizacije 

• statistična dopolnitev 

• ocenjevanje poteka 

 

Uporabniki bi morali metodologijo videti kot koristno orodje pri planiranju in vodenju projektov. 

Hkrati pomeni izhodišče za osnovna vprašanja projektnega vodenja: kdo, kaj, kdaj, kje, zakaj in 

kako. 

 

3.9.3 Planiranje rezerve za nepredvideno 

 

Plan rezerv vsebuje opis tveganja, domnevo obsega za razvijanje plana, verjetnost za pojav 

tveganja in njegov vpliv ter pravilen odziv nanj. Primer planiranja rezerv za kritične aktivnosti ali 

podobne okoličšine je prikazan spodaj (glej sliko 23). 

                                                      

Slika 23: Planiranje rezerv (Ralph, Irwin, 1997) 

 

3.9.4 Primerjava s prejšnjimi projekti 

 

V projektnem vodenju se udeleženci pogosto srečujejo s situacijami, ki so mnogokrat podobne 

prejšnjim - bodisi v ocenh projekta, ukrepanji zaradi slabega poteka, lahko obstajajo podobnosti s 

terminskim planom ali dokumentacijo, ki se je nanašala na prejšnji projekt. V takih primerih 

lahko določeno znanje oziroma informacije prenesemo in uporabimo v novem projektu. Koncept 
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ponovne uporabe je dragocen v obvladovanju tveganja, ker se lahko projektni vodje hitreje 

odločajo o napredovanju del oziroma aktivnosti. Zmanjšajo se zamude, poveča se učinkovitost, 

razjasnijo se zahteve itd. Glavni cilj tega je, da tako vodenje omogoča hitrejše in učinkovitejše 

obvladovanje tveganja. Orodja, ki nam pomagajo pri ponovni uporabi informacij, so:   

� specifikacije, 

� standardi, 

� realizacije, 

� podatkovne baze, 

� dokumentacije, 

� predloge. 

 

3.10 Vrste tveganj in kategorizacija  

 

Pojem tveganja je lahko interpretiran kot objektivno ali subjektivno tveganje. Razlika pa je v tem, 

da je objektivno tveganje enako objektivni verjetnosti. Ta je enaka razmerju med številom 

dogodkov z enakim izidom in številom vseh ponovitev dogodka, ob tem morajo veljati 

nespremenjeni pogoji in neskončno število ponovitev. Ob teh pogojih je objektivna verjetnost za 

vsakega enaka. (Williams, 1981). 

 

Subjektivno tveganje pa zadeva posameznikovo interpretacijo objektivnega tveganja in je neke 

vrste prepričanje. Dejavniki, kateri vplivajo na reakcijo posameznika – subjektivna tveganja 

(Williams, 1981): 

 

• negotovost, 

• možne izgube ali koristi in njihov vpliv na posameznika, 

• osebne značilnosti, 

• ljudje, ki jih odločitve zadevajo. 

 

3.11 Čista in špekulativna tveganja 

 

Glede na mogoče izide in njihove učinke tveganja razdelimo na čista in špekulativna tveganja. 

(Williams, 1989) 
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• Čista tveganja, ki so tista za katera obstaja možnost nastanka izgube, vendar ni možnosti 

za nastanek koristi. Primer takega tveganja bi lahko bile dolgotrajne nizke temperatur, ki 

bi onemogočale betonažo na objektu in s tem posledično povzročile zamik dokončanja 

objekta. Na škodi je lastnik objekta, kateremu pravočasna vselitev predstavlja dobiček za 

njegovo dejavnost. Če zmrzali ne bi bilo, lastnik ne bi imel koristi glede na svoj plan. 

 

• Špekulativna tveganja, pri njih obstaja možnost nastanka izgube in koristi. Primer takega 

tveganja je lahko vlaganje sredstev za nakup delnic nekega podjetja. Če podjetje posluje 

pozitivno, torej z dobičkom se za nakup njihovih delnic povečuje zanimanje s tem pa tudi 

raste njihova vrednost. Obratno je z delnicami podjetja, ki ustvarja zgubo. 

Čista in špekulativna tveganja se ločijo tudi po tem, da: 

• zavarovalnice zavarujejo le čista tveganja, 

• večina čistih tveganj je lažje predvidljivih – pojavijo se pri podobnih pogojih, zato jih je 

lažje napovedovati, 

• na račun špekulativnega tveganja ima družba možnosti pridobiti koristi, čeprav je 

posameznik na zgubi, 

• pri čistem tveganju predstavlja izguba za posameznika tudi izgubo za družbo. 

 

Čista tveganja oziroma zavarovalna tveganja obravnavajo (Kerzner, 2003): 

• direktno premoženjsko škodo, kjer gre za požarno zavarovanje, nezgodno zavarovanje, 

zavarovanje materialov na projektih, orodja in lastnine, 

• posredno izgubo, kjer lahko pogodbeniki zavarujejo posredno izgubo npr.: zaradi 

premeščanja opreme, odstranjevanje ruševin, 

• pravno odgovornost zaradi slabega načrtovanja izdelkov, neuspeha projekta, 

• kadrovsko: obravnava telesne poškodbe delavcev in povrnitev stroškov zaradi njihove 

zamenjave ter izgube ključnih delavcev. 

 

3.12 Odvisnosti med tveganji  
 

Če bi imeli projektni vodje neomejeno finančno kritje, bi lahko ugotovili množico tveganih 

dejanj, tako pomembnih kot nepomembnih. V realnosti pa se pojavlja nešteto možnih tveganj, ki 

jih ni mogoče enakovredno obravnavati, saj se razlikujejo po pomembnosti. Zato je nujno 

potrebna klasifikacija tveganj po pomembnosti.  
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Predpostavimo, da so tveganja kategorizirana glede na čas trajanja projekta, stroške in izvedbo. 

Tako kategorizirane prioritete tveganj so predstavljene v preglednici 5.  

 

       Preglednica 5: Prioritete tveganja (Kerzner, 2003): 

 Terminski plan Stroški Tehnična 

izvedba 

1. prioriteta    

2. prioriteta   

       

3. prioriteta  

       

 

   

Iz preglednice 5 je razvidno, da je terminski plan na prvem mestu. Torej je temu parametru 

posvečena največja pozornost, kar pa ne pomeni, da sta zapostavljeni drugi prioriteti. Projektni 

vodja mora terminski plan, stroške in tehnično izvedbo obravnavati istočasno, razlika je samo v 

vrstnem redu.  

 

Prioriteto, s katero je moč klasificirati tveganja na projektu, lahko določi vodja projekta, skrbnik, 

investitor ali stranka in je odvisna od vrste projekta. Vzemimo za primer investitorja, ki bi rad s 

čim manj stroški izpeljal projekt, a mu ni toliko pomembnen rok dokončanja. Njegova prva 

prioriteta bo torej cena, nato tehnična izvedba, terminski plan pa bo postavil na zadnje mesto.  

 

Če na upravljanje s tveganjem ne gledamo celostno, se nam lahko zgodi, da pri zmanjševanju 

enega tveganja zapostavimo druge, to pa ima lahko negativne učinke na projekt. Če bi hoteli 

projekt zaključiti v dogovorjenem roku in vemo, da ne bomo mogli hkrati zadostiti kvaliteti, 

stroškom in roku, moramo temeljito premisliti, kako postopati v takem primeru. Na izbiro imamo 

prevočasno izvedbo s slabšo kvaliteto, kar nam lahko na dolgi rok prinese kopico težav. Pojavijo 

se reklamacije, nezadovoljstva in nezaupanje do izvajalca projekta. To lahko škoduje podjetju in 

ga pripelje v finančno izgubo čez nekaj časa. Lahko se odločimo, da projekt zaključimo z zamudo 

z zavedanjem, da bomo morali plačati penale, vendar bomo več pozornosti namenili kvalitetni 

izvedbi. Odločitev je torej v naših rokah. Kaj lahko prinesejo posamezni ukrepi, ko hočemo 

zmanjševati tveganje, si lahko ogledamo v preglednici 6. 
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Preglednica 6: Tveganja in koristi pri različnih ukrepih (Kerzner, 2003) 

Ukrepi Možne koristi Tveganja 

• delanje nadur • hitrejše dokončanje • več napak, višja cena 

• povečevanje virov • hitrejše dokončanje • višja cena, delanje v več 

izmenah 

• vzporedno delo • hitrejše dokončanje • dvojno delo in dražja cena 

• zmanjšanje obsega  • hitrejše dokončanje in nižja 

cena 

• nezadovoljne stranke in 

nedoseganje ciljev 

• najem poceni delovne sile • nižja cena • več napak in daljše 

opravljanje dela 

 

3.13 Vpliv obravnavanja tveganja 

 

Projektne metodologije nudijo tehnike za vzpostavitev opozorilnega sistema in dajejo jasna 

navodila, kako se odzvati in voditi v primeru pojava tveganja. Opozarjajo na pomembnost 

grajenja sistema, kjer lahko shranjujemo podatke o vzrokih nastanka tveganj.  

 

Obravnavanje tveganja je pomembno zaradi možnih različnih toleranc oziroma dopuščanj 

tveganja, ki jih imajo lahko vodilni ljudje. Varnostne sistemske politike, postopki in usmerjanja 

obstajajo predvsem za spodnja tri področja (Slika 24). (Kerzner, 2003) 

 

         

   Slika 24: Toleranca tveganja (Kerzner, 2003) 

 

Toleranca uporabnika do tveganja je lahko višja ali nižja od tolerance, ki jo ima podjetje. Prav 

tako lahko na podlagi projektnih zahtev vsak projekt sprejema večje ali manjše tveganje kot ga 

predpisujejo organizacijski postopki.  
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Magnituda tveganja v veliki meri narekuje izbiro metodologije projektnega vodenja. 

Obravnavanje tveganja je zato veliko bolj kompleksno pri izogibanju, kot pri sprejemanju 

tveganja. Ko naraste magnituda tveganja, je potrebno poseči po boljših in zanesljivejših 

strategijah za obvladovanje tveganj (Slika 25), s tem pa se poveča tudi obseg potrebnih kontrol.  

 

               

Slika 25: Obseg obravnavanja tveganj (Kerzner, 2003) 

 

Vsekakor pa tega ne moremo početi v nedogled, saj se z obsegom kontrol zelo povečujejo stroški, 

povezani z izbrano strategijo. Kar bi v najslabšem primeru pomenilo, da podjetje ne bi zmoglo 

toliko investirati na področje obvladovanja tveganj in bi lahko zašlo v finančne težave.  

 

Ugotavljanje, kakšna je prava mera obvladovanja tveganj, ni lahka naloga. Če tveganja ne 

upoštevamo, lahko zaradi različnih zapletov pride do prekoračitve terminskega plana. Podobno se 

zgodi, če je kontrol, filtrov ter procesov ugotavljanj tveganj preveč, saj ti predstavljajo ovire na 

poti uresničevanja projekta. To velja tudi za prevelik obseg poročil, dokumentacij in sestankov 

glede tveganja, zato je potrebna pravšnja mera le teh. Vpliv mere obvladovanja tveganja glede na 

terminsko odstopanje si lahko ogledamo na sliki  26.  
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        Slika 26: Terminsko dostopanje napram meri obvladovanja tveganja (Kerzner, 2003) 
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4 PODATKOVNI SISTEMI IN BAZE PODATKOV  

 
 
Najpomembnejši in najkoristnejši komponenti pri upravljanju s tveganjem predstavljata znanje in 

izkušnje. Te imajo projektanti, ki se že vrsto let ukvarjajo s problemi na različnih področjih v 

gradbeništvu. Zaradi nesistematičnosti in neprimernosti hranjenja podatkov, v večini primerov pa 

zaradi neenotne politike tveganega poslovanja in baz podatkov o tveganju, problemih in odzivih 

nanj v predhodnih projektih, ki so se izvajali v Sloveniji, so znanje in izkušnje shranjene le v 

spominu projektantov. Zato bi bilo smiselno, da bi podatke o različnih vzrokih tveganja 

shranjevali v podatkovne baze in s tem zagotovili uporabnikom enostavno ter pregledno kasnejšo 

uporabo podatkov. 

 

Podatki predstavljajo nepogrešlijvo komponento pri vsakodnevnem funkcioniranju človeka v 

sistemu in so nujno potrebni za delovanje različnih organizacij – bank, zdravstvenih ustanov, 

trgovin, različnih podjetij. Ljudje s pomočjo podatkov ustvarjajo informacije, ki predstavljajo 

nova spoznanja o njih samih, okolju in družbi.  

 

V preteklosti so bili človekovi možgani edini informacijski sistem. Še vedno jih ljudje 

uporabljajo za sprejemanje informacij, njihovo shranjevanje in interpretiranje. Toda človek ima 

omejitve, koliko si lahko zapomni in kako hitro se lahko odloča. Zato danes računalniki igrajo 

pomembno vlogo, saj s svojimi velikimi kapacitetami lahko hitro obdelujejo raznovrstne in 

številne podatke.  

 

V današnjem času, ko sta tehnologija in ekonomija postali zelo intenzivni, mnoge organizacije po 

svetu – profitne ali neprofitne, gospodarske ali negospodarske – ne bi mogle delovati 

konkurenčno ali dosegati željenih rezultatov brez obvladovanja podatkovnih sistemov.  

 

Profesionalni uporabniki podatkovnih baz strogo ločijo pomen podatka in informacije v 

računalniškem jeziku. Podatek je mišljen kot zbirka bitov – samostojna binarna številka 0 ali 1.  

 

Mohorič označuje podatek, kot »predstavitev nekega dejstva na formaliziran način, ki je 

dogovorjen s konvencijo in primeren za komunikacijo, intrepretacijo ter obdelavo s strani človeka 

ali stroja. Podatek je diskreten, če se pri njegovi predstavitvi uporabljajo simboli, ali pa analogen, 

če se za predstavitev uporablja kakšna fizikalna veličina. Podatku se lahko pripiše pomen le v 
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določenem kontekstu«. Informacija pa je po njegovem »spoznanje, ki ga človek pripiše podatkom 

s pomočjo znanih konvencij, ki so uporabljene pri njihovi predstavitvi. Podatki posredujejo 

informacijo prejemniku, katerega sprejemna struktura je konsistentna z izbrano predstavitvijo 

podatkov in modelom sveta, na katerega se nanašajo«. (Mohorič, 1995) 

 

Sistem za upravljanje baze podatkov (angl. Database Management Systems – DBMS) ima 

naslednje osnovne komponente (Riccardi, 2003): 

• fizično bazo podatkov: zbirko datotek s pripadajočimi podatki, 

• načrt: specifikacijo o vsebini informacij in logični povezavi v fizični bazi podatkov,  

• pogon podatkovne baze: program, ki omogoča ljudem dostop do vsebine podatkovne 

baze, 

• določitev podatkov in upravljalni jezik: programski jezik, kot je Java ali SQL (angl. 

Structured Query Language), ki razvijalcem programske opreme omogoča določitev 

načrta in dostop do baze podatkov. 

 

Ljudje lahko operirajo s podatki preko osebnega računalnika, na katerem je instalirana ustrezna 

programska oprema za upravljanje z bazami podatkov kot npr. Microsoft Access. Program lahko 

deluje preko strežnika, ki povezuje uporabnika z nekim računalnikom, na katerem se shranjujejo 

podatki v obliki tabel (Slika 27). Ločenost uporabnika in strežnika omogoča računalniku-

strežniku bolj varno delovanje, centralno lokacijo in daje možnost uporabniku, da je lociran na 

več mestih.  

 

            

Slika 27: Povezava uporabnik strežnik (Riccardi, 2003) 

 

»Podatkovna baza je model okolja, ki služi kot osnova za sprejemanje odločitev in izvajanje 

akcij«. (Mohorič, 1995) Iz tega sledi, da podatki za organizacijo pomenijo osnovo, na kateri 
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temelji njeno celotno delovanje. Torej je potrebno s podatki, kot z ostalimi sredstvi v organizaciji, 

smiselno upravljati. To pomeni: 

• Zagotavljanje razpoložljivosti podatkov. 

• Nadzor nad uporabo podatkov, v katerega okvir sodi skrb za: 

� celovitost (integriteto) podatkov, 

� uporabo podatkov v skladu z njihovim namenom, 

� uporabnost podatkov tudi v prihodnje. 

 

Podatki shranjeni v podatkovni bazi morajo zagotavljati optimalno razpoložljivost, kar pomeni 

(Mohorič, 1995): 

• učinkovit dostop, 

• sočasno na voljo vsem uporabnikom, 

• dostopnost ves čas do vseh vrst podatkov. 

 

V podatkovni bazi so zbrani notranji, zgodovinski in kvantitativni podatki (Slika 28), ki se jim za 

uspešno povezovanje z okoljem dodajajo tudi zunanji podatki. Kvalitativni podatki in napovedi 

se običajno pridobivajo z usteznimi obdelavami.  

 

                                                                               

Slika 28: Vrste podatkov (Mohorič, 1995) 
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4.1 Grajenje ER modelov 

 

ER (Entity Relationship) modeliranje je tehnika podatkovnega modeliranja na visokem nivoju, ki 

omogoča načrtovalcem izdelavo natančnega in uporabnega predstavitvenega modela. ER modeli 

so najbolj izraženi v obliki grafičnih diagramov, ker ti omogočajo lažje komuniciranje v fazi 

zasnove med razvijalci in uporabniki.  

 

Pred vzpostavitvijo baze podatkov je le-to potrebno načrtovati. Začetni korak je pridobivanje 

informacij o problemskem področju in potrebah, ki jih ima uporabnik. Zanimajo nas torej 

podatki, ki naj bi bili v bazah, njihove povezave ter omejitve.  

 

ER modeli oziroma modeli entitet-povezav nam predstavljajo konceptualni načrt baz podatkov. 

Sestavine podatkovnega modela so (Muller, 1999):  

• entiteta: podatkovni predmet, o katerem lahko zbiramo različne podatke, 

• atribut: lastnost entitete, 

• povezava: zveza med dvema ali več entitetami. 

 

Poznamo tri tipe glavnih povezav med entitetami (Riccardi, 2003): 

• ena proti ena: entiteta ima lahko samo eno povezavo z drugo entiteto, 

• ena proti mnogo: prva entiteta ima lahko več povezavo z drugimi, medtem, ko imajo te 

samo eno povezavo s prvo,  

• mnogo proti mnogo: entitete na obeh straneh so lahko povezane z več različnimi 

entitetami.  

 

Kot je bilo že omenjeno, so ER diagrami v veliko pomoč pri načrtovanju baze podatkov. Primer 

takega diagrama si lahko ogledamo na sliki 29, kjer pravokotniki predstavljajo entiteto, elipse 

pripadajoče atribute, črte med njimi pa njihove povezave.  
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    Slika 29: ER diagram za entitetno in atribute (Riccardi, 2003) 

 

4.2 Podatkovni modeli in relacijske sheme 

 

Poznamo naslednje vrste podatkovnih modelov (Bobek, Sternad, 2004, tema 14): 

• hierarhične: datoteke so med seboj povezane v drevesno strukturo, kjer je možen dostop 

do posamezne datoteke le preko njene nadrejene, 

• mrežne: datoteke so med seboj povezane v mrežno strukturo, kjer je možen neposreden 

dostop do posamezne datoteke ali pa dostop do vnaprej definiranih povezav,  

• relacijske: datoteke so med seboj povezane preko izvajanja operacij relacijske algebre in 

ne le preko vnaprej definiranih povezav, 

• objektne. 

 

Hierarhični in mrežni modeli niso nikoli dovolj dobro opravljali sočasnih funkcij – shranjevanja 

podatkov in njihove učinkovite obdelave. Relacijski modeli, ki predstavljajo množico oziroma 

sistem med seboj povezanih tabel, neposredno dostopnih na uporabniku prijazen način, pa to 

učinkovito omogočajo. Uporabnikova naloga je torej, da natančno definira podatek, ki ga zanima 

potem pa tega ni treba iskati skozi celotno hierarhijo tabel. (Powell, 2006) 

 

Kot že rečeno, so pri relacijskih podatkovnih modelih podatki razvrščeni v dvodimenzionalnih 

tabelah. Praviloma so v eni tabeli zbrani podatki o vseh entitetah nekega entitetnega tipa ali vseh 

povezavah nekega tipa povezav. Vrstice v teh tabelah predstavljajo entitete ali povezave, medtem 

ko stolpci predstavljajo pripadajoče atribute (Preglednica 7). (Jaklič, 2002) 
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Preglednica 7: Primer tabele entitet in atributov 

PROJEKT_ID PROJEKT DOKONČANJE CENA 

1 Obnova mostu 7.8.2006 15.000.000,00 

2 Izgradnja vrtca 31.12.2007 200.000.000,00 

3 Stanovanjsko naselje 31.5.2007 1.000.000.000,00 

4 Poslovni objekt 15.4.2007 500.000.000,00 

 

Glavni ključ relacije je v tem primeru PROJEKT_ID, kar pomeni, da se v tem stolpcu ne moreta 

pojaviti isti vrednosti hkrati. Vsak projekt dobi svojo identifikacijsko številko in je z njo enolično 

določen. Seveda pa imamo lahko v relaciji več atributov, ki skupaj v kombinaciji tvorijo ključ. 

Pravimo, da ima taka relacija sestavljen ključ.  

 

O ključih relacij velja (Jaklič, 2002):  

• relacija ima lahko več kandidatov za ključ, od katerih izberemo enega za glavni ključ, 

ostali pa so nadomestni ključi, 

• glavni ključ relacije ne more imeti v dveh vrsticah iste vrednosti, 

• glavni ključ označimo tako, da ga podčrtamo, ostalim atributom pravimo naključni 

atributi, 

• vsi naključni atributi so odvisni od glavnega ključa, 

• če nimamo v relaciji atributa, ki bi sam zadoščal zahtevam za glavni ključ, izberemo za 

glavni ključ ustrezno kombinacijo atributov, ki ji pravimo sestavljen glavni ključ. 

 

Relacjski model vsebuje relacijske sheme, katere navajajo strukture tabel. Ob prikazovanju relacij 

nas večkrat zanima le struktura relacije, zato ne prikazujemo celotnih tabel. Struktura relacij ves 

čas ostaja ista, medtem ko se lahko vrednosti v posameznih tabelah spreminjajo.   

Zgornjo preglednico (Preglednica 7) bi lahko prikazali kot relacijsko shemo takole: 

 

PROJEKT(PROJEKT_ID, PROJEKT, DOKONČANJE, CENA). 

 

V podatkovni bazi imamo ponavadi več relacijskih shem. Na primer: 

PROJEKT(PROJEKT_ID, PROJEKT, DOKONČANJE, CENA), 

AKTIVNOST(AKTIVNOST_ID, AKTIVNOST), 

VODJA-PROJEKTA(V-P_ID, IME, PRIIMEK, NASLOV, TELEFON). 
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Podatke iz teh relacij lahko tudi povezujemo. Če nas recimo zanima kdo je vodja projekta na 

posameznem projektu, moramo povezati relaciji PROJEKT in VODJA-PROJEKTA. V tem 

primeru je pogoj, da imata obe entiteti skupni atribut, preko katerega je možna povezava. Ker v 

našem primeru nimamo skupnega atributa, dodamo v relacijo PROJEKT atribut V-P_ID. S tem 

dobimo: 

 

PROJEKT(PROJEKT_ID, PROJEKT, DOKONČANJE, CENA, V-P_ID), 

VODJA-PROJEKTA(V-P_ID, IME, PRIIMEK, NASLOV, TELEFON). 

 

V relacijskem modelu lahko povezave med entitetami prikažemo na dva načina (Jaklič, 2002):  

1. Če med entitetnima tipoma obstaja povezava 1:1 ali 1:N v relacijo na strani N dodamo 

glavni ključ relacije na strani 1. V našem primeru je vodja projekta lahko na več projektih, 

projekt pa ima lahko samo enega vodjo. Torej je na strani N relacija PROJEKT.  

 

2. Če med entitetnima tipoma obstaja povezava (M:N), mnogo proti mnogo, tvorimo novo 

relacijo, ki je povezava med entitetama. Glavni ključ relacije mora biti sestavljen iz 

glavnih ključev relacij, ki ju povezuje. V našem primeru bi to bila povezava entitet 

PROJEKT in AKTIVNOSTI, saj je na projektu več aktivnosti, vsaka aktivnost pa se 

lahko pojavi na več projektih npr.: izkop gradbene jame, betoniranje temeljev, zidanje 

sten... 

 

V drugem primeru tvorimo relacijo SPREMLJANJE, tako dobimo: 

 

PROJEKT(PROJEKT_ID, PROJEKT, DOKONČANJE, CENA, V-P_ID), 

AKTIVNOST(AKTIVNOST_ID, AKTIVNOST), 

SPREMLJANJE(PROJEKT_ID, AKTIVNOST_ID). 

 

Ko imamo pripravljene relacijske modele, lahko vzpostavimo dejansko bazo podatkov. Obstaja 

kar nekaj orodij, ki nam omogočajo ustvariti podatkovno bazo. Najbolj znana so FoxPro, dBase 

(velja za prvo tržno uspešnico in še danes igra pomembno vlogo) ter MS Access. Slednji je dokaj 

priljubljen med uporabniki, saj ponuja številne možnosti upravljanja s podatki ter je zelo 

razširjen, ker je del Microsoft Office.  
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4.3 MS Access 

 

Microsoft Access je zelo pogost pripomoček za upravljanje s podatkovnimi bazami in temelji na 

principu relacijske podatkovne baze. Baza podatkov v Accessu obstaja kot datoteka s končnico 

».mdb«. Omogoča nam (Bobek, Sternad, 2004, tema 14): 

• zbiranje in hranjenje podatkov v tabelah (table), 

• vnos, prikaz, spreminjanje in brisanje podatkov z obrazca (forms), 

• prikaz podatkov s poročili (reports), 

• iskanje shranjenih podatkov po želenih kriterijih s pomočjo poizvedbe (query). 

 

Preprostejše aplikacije za obdelavo baz podatkov, kot je komponenta Database programa 

Microsoft Works, shrani podatke v eni tabeli (nestrukturirana zbirka podatkov), medtem ko 

kompleksnejši programi kot je Access, shranjujejo podatke v medsebojno povezane tabele 

(relacijske zbirke podatkov). Pri tem je pomembna pravilna organiziranost zbirke podatkov, ki 

nam kasneje omogoča mnoge načine uporabe in obdelave podatkovnih baz. (Bradač, 2006)  

 

Tabele so namenjene shranjevanju podatkov, kjer vrstice predstavljajo entitete, stolpci pa atribute 

– lastnosti, ki jih ima posamezna entiteta.                              

                                

Ker imamo v Accessovi bazi podatke ponavadi shranjene v več tabelah, je zelo uporabna 

možnost, ki nam jo omogoča program, poizvedovanje (queries) z možnostjo povezovanja med 

tabelami. Tabele lahko povezujemo med seboj preko ključev in tako poizvedujemo po vseh 

želenih tabelah za določenimi podatki.  

 

Zbirko podatkov v Accessu lahko uredimo tudi v obliki obrazcev (forms), kar je ena od možnosti 

njihovega prikazovanja. Obrazce uporabljamo predvsem takrat, ko bi uporabnika veliko število 

tabel lahko zmedlo, ali pa preprosto želimo tak prikaz. Pri taki obliki je enako možno 

dopolnjevanje podatkovne zbirke, brisanje in filtriranje. 

Naslednja oblika prikazovanja podatkov so poročila (reports), ki nam omogočajo neposredno 

tiskanje v pregledni obliki oziroma pošiljanje podatkov preko mreže nekomu, ki bo poročila 

tiskal. 
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Do sedaj so bile omenjene tabele, poizvedbe, obrazci in poročila, ki se v Accessu tudi 

najpogosteje uporabljajo za uporabo zmogljivih in uporabnih zbirk podatkov. Vendar pa si za 

celovito uporabo podatkov pogosto pomagamo tudi s (Bradač, 2006): 

• stranmi (pages) – imenujejo se strani za dostop do podatkov – ki jih izdelamo za 

uporabnike spleta in intraneta, da le-ti lahko podatke vidijo, zaganjajo poizvedbe, vnašajo 

podatke v obrazce, 

 

• makri (macros), ki nam avtomatizirajo in pospešujejo določeno zaporedje opravil, ki se 

ponavljajo, 

 

• moduli (modules), ki so zmoglivejši od makrov, so napisani v programskem jeziku 

Microsoft Visual Basic for Application (VBA) in ga uporabljamo za izvajanje 

zahtevnejših nalog. 
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5 OBVLADOVANJE TVEGANJA S POMOČJO METODE ZA 
OCENJEVANJE ZAMUD NA ILUSTRATIVNEM ZGLEDU  
 
 

Na prvi pogled se zdi obravnavanje projektnih zamud dokaj enostavno opravilo, saj predstavljajo 

neko vrednost, ki preseže planirani konec projekta. Vendar so v končni fazi zamude vedno 

povezane s financami ali bolje rečeno: z denarjem.  

 

Z vzporednim beleženjem vseh odstopanj in vzrokov v podatkovne baze, bi nam ti podatki 

koristili pri analizah o krivdi za zamudo. Več podatkov obvladujemo, boljše so končne analize. 

 

Zaradi obveznega plačevanja penalov, mnogokrat prihaja do sporov, kdo in koliko je posamezni 

izvajalec kriv za nastalo zamudo, prav zaradi tega pa je analiziranje v tem primeru še toliko 

pomembnejše. Natančni in pravični rezultati temeljijo na metodologiji uporabe analitičnih tehnik, 

s katerimi morajo biti na samem začetku projekta seznanjeni tudi izvajalci, ker se je s tem 

mogoče izogniti kasnejšim sporom o krivdi za zamudo. 

 

Predlagano metodologijo sestavlja pet korakov: 

• zbiranje podatkov, 

• analiziranje podatkov, 

• identifikacijo vzrokov, 

• klasifikacijo vrste vzroka in 

• dodelitev odgovornosti. 

 

Hkrati pa odgovarja na sledeča vprašanja: 

• kolikšna je zamuda, 

• kje in kdaj je nastala, 

• zakaj je nastala, 

• kako je nastala, 

• kdo je odgovoren. 

 

Prvi korak je zbiranje relevantnih informacij, ki nam bodo pomagale pri samem procesu. Nekaj 

metod zbiranja informacij si lahko ogledamo spodaj: 

• pregled osnovnega terminskega plana za potrditev zahtevanega dokončanja projekta, 
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• pregled poročila o napredovanju projekta, saj lahko odkrijemo morebitne zamude, ki bi 

ogrozile dokončanje projekta, 

• pregled dopisov o projektu, saj lahko nekateri zapisi predvidevajo zamudo, 

• pregled zahtev o spremembi projekta, ker so te mnogokrat izvor zamude, 

• pregled plačilnih zahtev in poročil, 

• intervjuji z osebjem na terenu, ker največ lahko povedo o sami gradnji in njenih 

problemih. 

 

Analiziranje podatkov lahko izvedemo s pomočjo CPM metode (Critical Path Method), ki 

izvrednoti terminski plan po vseh možnih časovnih odstopanjih dejavnosti. Smisel 

preračunavanja zgodnjih in poznih terminov po metodi CPM je v tem, da s pomočjo teh podatkov 

dobimo rezervne čase vsake dejavnosti (časovno okno) in določimo kritično pot mreže. Lahko 

omenimo štiri oblike CPM terminskih planov: 

• planirani (As Planned) prikazuje oceno trajanja dejavnosti in zaključek projekta, 

• realistični-planirani (A Realistic As Planned) predstavlja revizijo planiranega plana in je 

njegova realnejša verzija, 

• posodobljeni (Updated) predstavlja sprotno beleženje sprememb in odstopanj v trajanju 

dejavnosti, 

• dejanski (As Built) predstavlja zapis dejanskih začetkov in koncev dejavnosti, kot so bile 

izvršene. 

 

Primer projekta, ki je namenjen ilustraciji uporabe metode za ocenjevanje zamud, je prikazan v 

obliki modificiranega gantograma (Slika 30), kjer zaporednost (odvisnosti) dejavnosti lahko 

prikazujemo s puščicami. Ta oblika je pregledni grafični prikaz za primerjavo dejanske izvedbe 

tipičnega gradbenega projekta glede na planirani. Izračun zamud v tem zgledu temelji na 

terminskem planu posameznih dejavnosti, na dejanskih začetkih in dejanskih koncih vseh 

prisotnih dejavnosti ter na povezavah dejavnosti na način konec-začetek (FS) in začetek-začetek 

(SS), kar se v praksi tudi uporablja.  
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  Slika 30: Potek izvedbe ilustrativnega zgleda glede na sprejeti terminski plan 

 

5.1 Pojasnitev parametrov pri analiziranju časovnega odstopanja aktivnosti  
 
Formule parametrov in njihove izpeljave za časovno odstopanje aktivnosti so podrobneje 
predstavljene v diplomskem delu (Forca, 2005). Sam sem jih uporabil v programu MS Access in 
s tem dobil vse želene parametre za omenjeno metodo. 
 

• začetek izvajanja dejavnosti: 

Si
B … planirani začetek dejavnosti "ai" ("Baseline Start time"), 

Si
A … dejanski začetek dejavnosti "ai" ("Actual Start time"), 

Si
C … možen začetek dejavnosti "ai" zaradi neposredno predhodnih dejavnosti ("Could 

Start time"),  

 

• konec izvajanja dejavnosti: 

Fi
B … planirani konec dejavnosti "ai" ("Baseline Finish time"),  

FP
B

 … planirani konec projekta ("Project Baseline Finish time"), 

Fi
A … dejanski konec dejavnosti "ai" ("Actual Finish  time"), 

FP
A … dejanski konec projekta ("Project Finih time"), 

Fi
C … možen konec dejavnosti "ai" zaradi neposredno predhodnih dejavnosti ("Could 

Finish time"),  

 

• trajanje dejavnosti: 

Di
B … trajanje dejavnosti "ai" po planskemu izhodišču ("Baseline Duration"), 

Di
A … dejansko trajanje dejavnosti "ai" ("Actual Duration"), 

• odstopanja: 

Vi
S … odstopanje dejanskega začetka dejavnosti "ai" glede na planiran (primerjalni) 

začetek ("Variation in the Start"), 
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Vi
F … odstopanje dejanskega konca dejavnosti "ai" glede na planiran (primerjalni) konec 

("Variation in the Finish"), 

Vi
D … razlika med dejanskim trajanjem dejavnosti "ai" in njenim pričakovanim 

(planskim) trajanjem ("Variation in the activity Duration"), 

Vi   
 … terminsko odstopanje dejavnosti "ai" zaradi lastnih vzrokov ("Variation of  

activity"), 

Vi
S,C-B … odstopanje možnega začetka dejavnosti "ai" glede na planirani začetek te 

dejavnosti ("Variation in the Start time caused by the preceding activities- the difference 

between Could Start time and Baseline Start time"), 

Vi
F,C-B … odstopanje možnega konca dejavnosti "ai" glede na planirani konec te 

dejavnosti ("Variation in the Finish time caused by the preceding activities-the difference 

between Could Finish time and Baseline Finish time"), 

Vi
S,A-C … odstopanje dejanskega začetka dejavnosti "ai" glede na možni začetek te 

dejavnosti ("Variation in the Start time due to causes associated with the activities itself- 

the difference between Actual Start time and Could Start time"), 

Vi
F,A-C … odstopanje dejanskega konca dejavnosti "ai" glede na možni konec te dejavnosti 

("Variation in the Finish time due to causes associated with the activities itself-the 

difference between Actual Finish time and Could Finish time"), 

VP
F … odstopanje dejanskega zaključka projekta glede na planirani zaključek ("Variation 

in the Project finish time "), 

 

• prispevki zamude: 

Cij … prispevek dejavnosti "ai" k zamudi določene, sledeče in odvisne dejavnosti "aj" ter 

služi kot pomožni račun ("Contribution of activity for Succeeding activity delay"), 

Pij
D … dejanski prispevek dejavnosti "ai" k projektni zamudi določene, sledeče in odvisne 

dejavnosti "aj" ter služi kot pomožni račun ("Project Delay of succeeding activity caused 

by preceding activity"), 

Pi
D … projektno zamudo pri dejavnosti "ai" z upoštevanjem zamudnih prispevkov vseh 

predhodnih dejavnosti ("Project Delay at activity contributed by this and all other 

preceing activities"), 

Pi
C …  dejanski prispevek dejavnosti "ai" k projektni zamudi ("Contribution of activity in 

Project delay") in je glavni rezultat analize. 
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5.2 Spremljanje z MS Accessom 
 
Z računalniškim programom MS Access lahko izvedemo analizo metode za ocenjevanje zamud 

za vmesno fazo ali na koncu projekta. Program nam je v pomoč, saj lahko z njegovimi mnogimi 

možnostmi pridobivanja različnih podatkov s pomočjo poizvedb dobimo željene vrednosti 

oziroma parametre, ki nam kasneje služijo pri obravnavani metodi. 

 

Prvi korak pri obravnavani metodi je shranitev ilustrativnega primera iz programa MS Project v 

program MS Access (Slika 31), saj s tem dobimo vse potrebne podatke za nadaljnjo analizo.  

 

                         

Slika 31: Shranjenje ilustrativnega primera iz programa MS Project v program MS Access 

 

Za lažjo in bolj pregledno obdelavo je najbolje, da tabele, ki vsebujejo ključne podatke, uvozimo 

v novo datoteko (Slika 32) [File > Get External Data > Link Tables]. To datoteko lahko 

poimenujemo »aplikacija«, ker v njej obdelujemo podatke, jih pridobivamo in na novo 

preoblikujemo do želenih vrednosti.   
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Slika 32: Uvoz ključnih podatkov v novo datoteko 

 

Odlična lastnost Accessa je, kot je bilo že omenjeno, možnost poizvedovanja (angl. queries). 

Podatke poiščemo s poizvedbami (Slika 33) zato, da jih prikažemo, spreminjamo ali analiziramo 

na različne načine, rezultate pa uporabimo tudi kot osnovo za druge Accessove predmete 

(obrazci, poročila, strani, makroji in moduli).  

 

     

Slika 33: Pridobivanje podatkov s poizvedbami 

 

V našem primeru moramo opraviti kar nekaj takih poizvedb, da pridemo do želenega 

»koncentrata« podatkov, ki nam omogočajo spremljanje projekta po metodi ocenjevanja zamud. 

Končna preglednica (Slika 34) s parametri izgleda takole: 
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Slika 34: Končna tabela z vsemi potrebnimi parametri 

 

Kot že rečeno, so vsi potrebni podatki pridobljeni na podlagi uporabe MS Access-a (poizvedbe, 

programski jezik VB), zato je v našem primeru dobrodošlo, da te parametre izvozimo nazaj v MS 

Project. S tem pa slednjemu dajemo dodatno možnost spremljave projekta.  

5.3 Spremljanje z MS Projectom 
 
Pri spremljanju projektov je potrebno projektne dejavnosti vnesti v program in jim določiti vse 

znane lastnosti.  

Postopek spremljave z MS Projectom lahko opišemo s spodaj opisanim postopkom: 

� zapišemo imena dejavnosti pod stolpec [Task Name], 

� uredimo odvisnosti med dejavnostmi [Meni: Project→Task Information→jeziček: 
Predecessor (odvisnost s predhodnimi dejavnostmi; vsi možni tipi odvisnosti in zamiki)], 

� zapišemo lastnosti koledarja [Meni: Tools→Change Working Time→izberemo lahko enega 
od treh predlaganih, sicer pa uporabimo gumb: New; New→označiti: Create new base 
calendar→zapišemo ime novega koledarja: Name→prilagodimo koledar], 

� opredelimo projekt [Meni: Project→Project Information→izpolnimo okenca; pozornost pri 
opredelitvi uporabljenega koledarja], 

� dejavnostim omogočimo zgodnje začetke [označimo vse dejavnosti v stolpcu→desni gumb 
miške→Task Information→jeziček: Advanced→Constraint type→As Soon As Possible]; 
služi kot podlaga za izračun časovnih oken dejavnosti, 

� dejavnostim določamo trajanje [Duration], 

�  vstavimo v tabelo nove stolpce za zgodnje in pozne začetke in konce dejavnosti ter časovne 
rezerve [kliknemo na obstoječi stolpec, pred katerim bi radi nov stolpec→Meni: 
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Insert→Column→Field name→Early Start, Early Finish, Late Start, Late Finish, Free Slack, 
Total Slack itd.], 

� nastavimo okno grafičnega pogleda na projekt: za časovni prikaz [Meni: 
Format→Timescale→ nastavimo mersko enoto, oblika prikaza je lahko v treh nadstropjih 
itd.]; uporabimo še nastavitve glede črtnega prikaza in prikaza dejavnosti [Meni: Format ali 
desni gumb miške→Gridlines, Bar Styles], 

� obvezno shranimo plan kot osnovni terminski plan [Meni: Tools→Tracking→Save Baseline]. 

 

Od tu dalje se lahko začne dejansko spremljanje plana: 

� po shranitvi osnovnega terminskega plana se podatki iz polja [Start] in [Finish] avtomatično 
prekopirajo v polja [Baseline Start] in [Baseline Finish],   

� vstaviti (vrniti oz. "Insert") je potrebno stolpce (parametre analize), ki jih želimo videti oz. 
spremljati, 

� zaželeno je postaviti zadnjim dejavnostim v nizih terminski rok za dokončanje projekta zaradi 
vizualnega efekta prikaza planiranega konca projekta [Meni: Project→Task 
Information→Advanced→ Deadline→ "vpis datuma za dokončanje projekta"], 

�  v funkciji [Format→Bar Styles] moramo določiti grafični prikaz na desni in še druge 
podrobnosti; program omogoča veliko možnih kombinacij pogledov na časovni prikaz,  

� preostane le še sprotno vnašanje podatkov za dejansko izvedbo ([Actual Start] in [Actual 
Finish]), 

� možnost imamo tudi filtrirati informacije ([Meni: Project→Filtered…]), vključiti poglede iz 
drugih zornih kotov ([Meni: Project→View→…]) itd. 

 

5.4 Spremljava, analiza in napovedovanje konca projekta pri ilustrativnem zgledu  
 
Primer spremljave je prikazan v preglednici 8 in na sliki 35. Oba navedena predmeta sta v MS 

Projectu združena v skupno okno, kar omogoča večji pregled nad dogajanjem. Vnašanje 

podatkov dejanskega stanja izvedbe poteka preko ročnega vnosa parametrov Si
A (SiA) in Fi

A 

(FiA). 

 

Naša naloga je torej sprotno vpisovanje oz. vnašanje dejanskega poteka dejavnosti. V programu 

MS Project za vsako dejavnost ob njenem začetku zabeležimo datum, ko je le ta začela in isto 

ponovimo ob njenem zaključku (Preglednica 8). Po vnosu dejanskega stanja v polje SiA in FiA 

naš projekt shranimo v Accessu ([File→Save As→Save as type→Microsoft Access Database 

(*.mdb) →ime datoteke z enakim imenom]). Ostane nam še odpriranje naše aplikacije v 
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programu Access, ki nam samodejno posodobi parametre in jih pripravi za zapis v program MS 

Project.  

 

Zadnji korak za prikaz posodobljenih parametrov v programu MS Project je odpiranje projekta iz 

Accessove datoteke ([File→Open→Files of type→Microsoft Access Database (*.mdb) →ime 

datoteke z enakim imenom]). Prikaže se nam projekt z vsemi parametri in grafičnim prikazom v 

gantogramski tehniki.  

 

Posebnost takega načina spremljanja po metodi za ocenjevanje zamud je tudi v tem, da imamo, 

kot je razvidno v preglednici 8, v Projectu zapis odstopanj za posamezno dejavnost in tudi 

prispevek te dejavnosti k končni projektni zamudi. Ta se izraža v dnevih (PiC) in v odstotkih 

krivde za nastalo projektno zamudo (Prispevek %).  

 

S takim načinom je omogočeno projektnemu vodji enostavno in pregledno vodenje projektov, 

določevanje zamud aktivnosti in projekta ter pravična končna porazdelitev odgovornosti za 

projektno zamudo. 

 

Spremljava projekta pa je izredno pregledna tudi v gantogramski tehniki. Kot je razvidno s slike 

35, je možno s pogledom na gantogram hitro zaznati, katere dejavnosti pospešujejo oziroma 

zavirajo potek projekta. Zelene črte pomenijo, da se je dejavnost predčasno začela in omogočila 

pospešitev dokončanja, medtem ko rdeče črte pomenijo zamudo na začetku oziroma podaljšanje 

trajanja. Svetlo modra barva predstavlja možen začetek dejavnosti in njeno možno trajanje, 

temno modra pa njeno dejansko izvedbo.      
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           Preglednica 8: Prikaz časovne spremljave ilustrativnega primera s programom MS Project 
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Slika 35: Gantogramski prikaz ilustrativnega primera  

 
Konec spremljave projekta nastopi ob zaključku zadnje dejavnosti. Ob pogledu na preglednico 9 

in sliko 36 vidimo končne vrednosti parametrov, deleže prispevkov dejavnosti k projektni zamudi 

ter grafični prikaz končnega stanja izvedenega projekta.  

 

         

 

 

 

 

 

 

 

 

 

 

 

    p lanirana izvedba     

planirani konec projekta   

  mogoča izvedba   
    odvisnost   

dejanska izvedba 
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         Preglednica 9: Prikaz spremljave ilustrativnega primera z MS Projectom po končanem projektu 
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Slika 36: Gantogramski prikaz dokončanja projekta  

 

Program MS Project nam sicer omogoča beleženje vzrokov za nastalo zamudo, vendar sem 

zaradi boljše preglednosti in enostavnejšega vnašanja in obdelovanja vzrokov za zamude rešitev 

poiskal v Accessu. V že omenjeni Accessovi aplikaciji, ki je povezana s programom MS Project, 

sem izdelal obrazec (Slika 37), s katerim je mogoče spremljanje projekta na podlagi metode za 

ocenjevanje zamud. Ta obrazec vsebuje vse ključne parametre in tudi prispevke posameznih 

dejavnosti k projektni zamudi.  

 

    p lanirana izvedba     

planirani konec projekta   

  mogoča izvedba   
    odvisnost   

dejanska izvedba 
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Slika 37: Izdelan obrazec v Accessu  

 

Obrazec (Slika 37) pa vsebuje tudi podobrazec, ki predstavlja vnosno polje za vpisovanje 

vzrokov za nastalo zamudo. Razvidno je, da je pri dejavnosti 1 prišlo do enodnevnega odstopanja 

začetka zaradi vremena in dvodnevnega odstopanja trajanja zaradi slabe produktivnosti. Vendar 

kljub temu projektna zamuda zaradi dejavnosti 1 znaša en dan, tako da moramo vzroka razdeliti 

po prispevanih deležih, kar je razvidno v polju dT Projekta. S takim načinom dobimo razdelitev 

zamude projekta po vzrokih, kar lahko grafično prikažemo tudi z vrtilnih grafikonom (Slika 38).  

 

                                 

Slika 38: Vrtilni grafikon za spremljanje odstopanj po vzrokih 
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Z grafikona (Slika 38) je razvidno, da so bili največji razlog za zamudo dobavitelji, saj so k 

projektni zamudi prispevali dva dneva in pol, produktivnost je bila drugi največji razlog, zadnjo 

oviro predstavlja vreme. Izvajalci so skupaj prispevali poldnevno pospešitev, dočim vodja 

projekta ni imel vpliva na zamudo. Z vrtilnim grafikonom je mogoče enostavno prikazati tudi 

odstopanja po kategoriji. Če  nas zanima, zaradi katerih vzrokov je prišlo do odstopanja začetka 

dejavnosti, to lahko storimo z izbiro »začetek« v spustnem seznamu KAREGORIJA 

ODSTOPANJA. Prikaže se nam nov grafični zapis (Slika 39). 

 

                                 

Slika 39: Prikaz vzrokov za odstopanje začetkov 

 

Tovrstne analize so nam vsekakor v pomoč pri sprotnem spremljanju, saj na pregleden način 

pridobivamo podatke, ki nas opozorijo na nadaljnjo možno tvegano odvijanje projekta. S 

pomočjo grajenja podatkovne baze torej lažje obvladujemo tveganja, ker so nam ti podatki na 

voljo tudi pri naslednjih primerljivih projektih in jih lahko uporabimo kot pomembne informacije 

pri preprečevanju vzrokov za nastale zamude. 
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6 ZAKLJUČEK 
 

V podjetjih, ki se ukvarjajo z gradbenimi dejavnostmi, je moč opaziti vse večjo konkurenco na 

trgu in s tem posledično tudi pritisk na zmanjševanje cene končnega produkta. Prav zaradi tega 

sta učinkovito vodenje projektov in racionalizacija še bolj nujna, saj nam na eni strani omogočata 

boljše pogoje za uspešno dokončanje projekta in kakovostnejše storitve na drugi pa zagotavljata 

zadovoljstvo končnega uporabnika.  

 

Gradbeni projekti so inherentno povezani z velikim številom raznolikih tveganj, zaradi česar 

moramo upravljanju s tveganji v takšnem projektu posvetiti posebno pozornost. 

 

Identifikacija, analiziranje, kontrola tveganja ter poročila o tveganju bi morali postati stalnica ob 

spremljavi projekta, saj bolj ko upoštevamo in se držimo zaporedja navedenih korakov, ki skupaj 

tvorijo cikel upravljanja s tveganjem, boljši so končni rezultati, začetna pričakovanja pa se na 

koncu izkažejo za točnejša in večje je naše zadovoljstvo ob končanju projekta. 

 

Prav zaradi tega so v zgodnji fazi še toliko bolj pomembni dobro definiranje ciljev projekta, 

pregledi projektnih planov, razgovori z udeleženci ter skrben pregled tehnične dokumentacije, v 

kasnejših fazah pa natančno spremljanje in kontroliranje projektov. Da se izognemo neugodnemu 

vplivu tveganja, preventivno ukrepamo, kar pomeni, da na neugoden trenutek ne čakamo, temveč 

ga poskušamo predvideti, nato pa z ustreznimi ukrepi preprečiti. Zato je nujna vzpostavitev 

varovalnega mehanizma.   

 

Vodenje projektov z metodo za ocenjevanje zamud je lahko eden od vzpostavljenih mehanizmov 

pri spremljanju in kontroliranju projektov. Prednosti te metode se pokažejo v spremljanju 

projektov v katerikoli fazi, napovedovanju nadaljnjega poteka izvedbe, razčlenitev končne 

projektne zamude po izvedenih dejavnostih in s tem prisotnih odgovornih udeležencev.  Ob tem 

pa nam sprotno grajenje baze podatkov o nastalih vzrokih pomaga pri analiziranju le-teh in lahko 

v prihodnosti prepreči morebitna tveganja, ki so se pojavljala na predhodnih projektih.  
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